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LETTER FROM THE EDITOR

We are extremely pleased to present this issue of the Journal of Economics
and Economic Education Research, an official publication of the Academy of
Economics and Economic Education Research, dedicated to the study, research and
dissemination of information pertinent to the improvement of methodologies and
effective teaching in the discipline of economics with a special emphasis on the
process of economic education.  The editorial board is composed primarily of
directors of councils and centers for economic education affiliated with the National
Council on Economic Education.  This journal attempts to bridge the gap between
the theoretical discipline of economics and the applied excellence relative to the
teaching arts. The Academy is an affiliate of the Allied Academies, Inc., a non profit
association of scholars whose purpose is to encourage and support the advancement
and exchange of knowledge, understanding and teaching throughout the world.

The Editorial Board considers two types of manuscripts for publication.
First is empirical research related to the discipline of economics.  The other is
research oriented toward effective teaching methods and technologies in economics
designed for grades kindergarten through twelve.  These manuscripts are blind
reviewed by the Editorial Board members with only the top programs in each
category selected for publication, with an acceptance rate of less than 25%.

We are inviting papers for future editions of the Journal for Economics and
Economic Education Research and encourage you to submit your manuscripts
according to the guidelines found on the Allied Academies webpage at
www.alliedacademies.org.

Dr. Larry R. Dale

www.alliedacademies.org
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ASSESSING GLOBALLY THEMED
LEARNING OBJECTIVES USING

OBJECTIVE EXAMINATION
RESULTS

Laura Fitzpatrick, Rockhurst University

ABSTRACT

In any course the instructor is faced with the need to structure the course
material and pedagogy in such a way to promote student learning, and to assess the
degree to which learning has happened.  The added challenge in the courses of the
author is that their courses are heavily laden with authentic learning projects,
interventions to develop communication skills, and interventions to increase student
motivation, all of which place increased demand on course time over and above
what covering the material in a standard lecture format would require.  An old
standby—the multiple-choice examination—has been retained in the author’s
courses as a means to conserve on precious time while still assessing student
learning beyond simply the level of student recognition of terms to comprehension,
application, analysis, and evaluation cognitive levels.  These higher cognitive levels
indicate increasing student ability and sophistication with material in a course.
Assessment of learning at these multiple cognitive levels can be achieved through
use of Bloom’s taxonomy of the cognitive domain in construction of examinations
as well as evaluation of learning patterns with specific foci such as learning of
international subject matter within a course. This paper outlines how objective
exams can be analyzed to determine the level of cognitive learning attained, how
existing exams can be modified or appended to reach higher levels of cognitive
learning, and how an instructor can use the information distilled from the project
to assess overall learning patterns in a course which in the case of this paper is
focused on the attainment of learning goals related to global themes.

INTRODUCTION

As professors we are called to meet multiple goals in every class we teach.
These include meeting course content and skill development learning goals, program
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level learning goals, and mission and topic specific learning goals established in
accordance with accreditation efforts. This is potentially a daunting task given
limited class time and an ever-present drive for continuous improvement. The author
has had great success in setting, measuring, and assessing attainment of these
multiple goals using a combination of objective examinations with explicit cognitive
level structuring ala Bloom’s Taxonomy (Bloom, 1956) to create assessment
opportunities that minimize class time usage, while providing learning goal
feedback. These efficiencies in addition to providing needed assessment data, also
allow for the use of additional assessment methods to meet goals objective exams
cannot achieve, such as demonstration of writing skills. This work begins with
examination of the general bias against objective examinations, followed by a
methodology that takes objective exams beyond many of these criticisms. This is
then used to show how the methodology has allowed the assessment of
internationally focused program goals in a Principles of Macroeconomics class. This
endeavor begins with the recounting of an experience likely shared by many
educators.

While evaluating a multiple-choice exam using Bloom’s Taxonomy of the
cognitive domain, a colleague looked over the shoulder of the author and
commented with a superior tone, “Multiple-choice exams, I used to give those.”
The author found the comment interesting for a number of reasons.  First, she did
not start her teaching career using this type of exam.  Only with experience did she
learn that they can be an integral and meaningful part of an arsenal of assessment
methods/techniques.  Second, she used to have the same superior attitude.  At first
she looked down on such assessment, but her attitude resulted from ignorance of the
potential that such a method affords.  Use of multiple-choice examinations has
become an integral part of survey courses because of the flexibility they can offer.

This colleague’s attitude as well as the authors’ own in early years of
teaching has been echoed by Bruce Alberts when president of the National Academy
of Sciences.  His criticism comes from his years teaching biochemistry to medical
students where “he was appalled to find they ‘were not learning anything.’ The
future doctors easily parroted back biochemical terms but failed to grasp the
concepts.  The culprit? Multiple-choice tests”(Carey, 1997) These are serious
allegations from a prominent educator, but even as a novice in the field of
biochemistry, one questions whether it is the particular use of the exam and not the
multiple-choice exam in general that is lacking.  The author has no problem
accepting Alberts’ claim that the exams show nothing if in fact the examinations are
designed in such a way that they only test rote knowledge.  “By emphasizing
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memorization and word association over conceptual knowledge, these tests are poor
judges of students’ abilities.” (Carey, 1997) But this criticism speaks largely to the
construction of the exam.  The author does agree that as a sole assessment tool, a
multiple-choice exam can be insufficient to meet certain learning objectives, but the
author proposes that it comprises a very effective component of a larger assessment
architecture.  Multiple-choice exams can be used to evaluate student ability on a
variety of cognitive levels.  The author believes that Alberts’ comments and efforts
would coincide with the proposal, as the direction he seeks is to get students to
“analyze data, not regurgitate facts.” (Carey, 1997) One needn’t in this case throw
the baby out with the bath water, instead, one can systematically evaluate and
reconstruct multiple-choice exams to address multiple levels of the cognitive domain
and situate these exams in a course assessment strategy.

Like many who came to teaching through content education rather than
teaching education, the author has reinvented or attempted to reinvent many a wheel.
The author began to use multiple-choice exams in survey courses for a very
pragmatic reason—there was a lot of material to be covered and hence a lot of
material for exams.  While the author does not find it necessary to test on every
single point examined in class or readings, relying solely on essay/short answer
exams was untenable.  When the author began using this testing method, she did not
simply want definitions or something parroted back to her.  She wanted students to
think critically, to apply concepts, to discern among complex answers.  This is a
challenging goal, yet is still doable.  

Just when the author was breathing a contented sigh from having
accomplished the goal of testing varying abilities, the wheel invented in 1956 rolled
by.  Surprisingly enough, that was not a discouraging experience.  There, before the
author, was a structure for examining exactly what she was doing, not simply based
on years of experience and a clear desire to develop critical thinking in students.
Here was a framework based on educational research.  Bloom’s Taxonomy provided
a logical and systematic articulation of what she intuitively knew and what she
wanted to accomplish in the assessment of student learning, and it was expressed far
more clearly and concisely than she could have done.  It was akin to a roadmap and
has become an indispensable tool in designing assessment for courses. Bloom’s
Taxonomy provides a great framework for an instructor to use when seeking to
create assessments in general and multiple-choice exams in particular.  



6

Journal of Economics and Economic Education Research, Volume 9, Number 3, 2008

BLOOM’S TAXONOMY

Bloom’s Taxonomy is “a hierarchy of educational objectives…which
attempts to divide cognitive objectives into subdivisions ranging from the simplest
behaviour to the most complex.” (Carneson, Delpierre & Master, 1996)  This is a
powerful tool for educators for it provides a system for creating assessment tools or
evaluating existing assessment tools with an eye to the types of student learning the
instructor seeks.  The scheme below summarizes the hierarchy and is followed by
descriptions of each of the levels.

EVALUATION


SYNTHESIS


ANALYSIS


APPLICATION


COMPREHENSION


KNOWLEDGE 

The base of the hierarchy is knowledge.  Student ability at this level would
require the recollection of material.  For the purposes of the author, questions at this
level have included definitions, identification of concepts, remembering facts.  If an
exam were to test only on this cognitive level, the concerns of Alberts identified
above would be entirely on the mark.  This is truly just parroting back information
with no deeper application or use of the information.  That is not to say that there
is no place for such question on a multiple-choice exam.  Ultimately the author’s
goal is to test at multiple levels of the cognitive domain for a number of reasons.
First, the author wants to see how students perform at different cognitive levels.  If
the author determined that students are not performing at any of these levels up to
their expectations, then the author can target teaching methods to address those
deficiencies. Second, given the hierarchical nature of the taxonomy, the author
wanted to include even the lowest level to measure student performance relative to
other levels.  Third, the author believed that the best examination has opportunities
for all students to succeed at some level.  Presenting an examination that is delivered
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only at the highest cognitive level can discourage learning and thwart motivation.
This is particularly so in the introductory level courses where the authors use
multiple-choice exams.

The second level of the hierarchy is Comprehension. “Comprehension is
defined as the ability to grasp the meaning of material…These learning outcomes
go one step beyond the simple remembering of material, and represent the lowest
level of understanding.” (Carneson, Delpierre & Master, 1996)  Comprehension
questions require the student to be aware of the context from which a fact or
definition or concept is derived.  For example, defining price elasticity of demand
would be a knowledge level question, while restating this elasticity in mathematical
form would represent comprehension.  Again, at this level there is not a high
cognitive achievement.  Students are still recalling information, but at a slightly
more sophisticated level since they are expected to translate words into a
mathematical form.

Application is the level at which students begin to take what they have from
the first two levels and use it in a meaningful way, that is to begin creating
something from what they have gained in Knowledge and Comprehension.  At this
level the student would be able to take the mathematical formula for price elasticity
of demand and apply it to new data to calculate what the actual value is. 

At the analysis level of the hierarchy students “break down material into its
component parts so that its organizational structure may be understood.” (Carneson,
Delpierre & Master, 1996) Students at this level need to have competence at the
previous levels in a topic to perform at the analysis level.  In the elasticity example,
a student would be required to interpret the meaning of a particular value for the
price elasticity of demand and analyze the potential impact of that value in a context.

The fifth level of the hierarchy is synthesis.  This level poses a significant
obstacle to the instructor seeking to use the various levels of the cognitive domain
to structure objective examinations.  Synthesis involves the creation of something
new from the cognitive achievements of the previous levels.  Because objective
examinations by their nature are not a venue for “creation,” the author has sought
to address this cognitive level through alternative assessment methods.

Evaluation is also a challenge in the use of multiple-choice exams, but it is
not an impossibility to test for this cognitive level in such exams. In the evaluation
level a student is expected to judge that which they are examining.  “Learning
outcomes in this area are highest in the cognitive hierarchy because they contain
elements of all the other categories, plus conscious value judgments based on clearly
defined criteria.” (Carneson, Delpierre & Master, 1996)
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USING BLOOM’S TAXONOMY TO EVALUATE MULTIPLE-CHOICE
EXAMINATIONS

The appeal of Bloom’s taxonomy lies in the systematic way it allows one
to construct assessment for student learning.  The author initially used the taxonomy
not to create new exams, but to evaluate existing examinations.  In the hierarchy, the
author saw much of what she was trying to accomplish, that is, assess student
learning at many different levels. Their terminology differed from that of Bloom, but
she wanted students to know the fundamental concepts, understand what they mean
and then use those and understand the importance of those concepts.  The author
was seeking “real-world” knowledge.  The challenge was to find out whether the
author was actuality testing the different levels sought, through use of Bloom’s
taxonomy.  Additionally her intent was to examine the cognitive level of student
learning in particular with respect to globally themed questions. This would allow
the author to establish achievement levels not only for course level program learning
objectives, but also those relating to program level goals consistent with AACSB
accrediting standards.

Evaluation of exams revealed internationally focused questions ranging
from the knowledge through the analysis cognitive levels. The author found that the
exams did have a high proportion of application and analysis question (the type of
cognition they seek), but there were still questions at the two lower levels of the
hierarchy.  There were no evaluation level questions, but in the process of research
have come across ideas for formulating some of these difficult questions for
inclusion in the multiple-choice exam. Student achievement levels were
commensurate with expectations for the different cognitive levels, that is, higher
percentage correct scores at lower cognitive levels than at higher ones. In this
analysis, the average percentages of correct answers for the different cognitive levels
were as follows: Knowledge, 89.25%; Comprehension, 72%; Application, 51.1%,
and Analysis 25%. This reveals the level of learning at different levels and provides
data for determination of whether learning objectives and program level learning
goals are being met.

By cross referencing the Bloom’s levels with content areas the author was
also able to determine areas where questions were bunched in certain areas of the
hierarchy, and this allows the author to address this to get a better spread of
cognition levels across content areas to track student performance at each level.
This additional layer of data, student performance at different cognitive levels and
by content, also reveals where students are excelling and where they are faltering.
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  This allows the author to address areas of concern through teaching interventions.
For example, analysis of the Principle of Macroeconomics exams evaluated for
international learning objectives revealed also that students were not performing as
well in equilibrium analysis as in other areas.  The instructor, armed with this
information, can then focus teaching to address this deficiency.  The analysis also
showed that students as a whole were performing very well at the
application/analysis levels.  This validates many of the techniques used in the course
to foster student learning.

STRUCTURING EXAMS USING BLOOM’S TAXONOMY

The author has evaluated a number of exams in different disciplines, but is
focusing in particular on the international focus of two exams administered multiple
times from a Principles of Macroeconomics course. Working with a colleague to
evaluate exams helps not only in categorization of the questions that do not
obviously fit into a particular category but also allows for inter-rater reliability in
classifications. 

The analysis performed on the Principles of Macroeconomics examinations
revealed that exam A had 5 comprehension level questions, 3 application questions,
and 1 analysis level question. Exam B had 1 knowledge, 2 comprehension, 4
application, and 1 analysis level question(s).  Although the author was pleased that
the largest single share of questions was at the application/analysis levels, which
reflected the objectives set for this introductory level course, there were no
evaluation level questions and disproportionately fewer questions from the lower
cognitive levels on exam B.  The analysis revealed an area to be expanded (more
lower level questions) and an area to be developed (evaluation level questions) but
was also validating insofar as the other content categories and cognitive levels
reflected the distribution of questions mirrored by goals.

Bloom’s taxonomy gives an instructor the opportunity for such analysis for
the improvement of assessment techniques, but can also be a starting point for the
creation of assessment that reflects the desired learning outcomes set by an
instructor in a course.  To aid in either of these outcomes, examples of multiple-
choice questions drawn from the exams at each of the cognitive levels are presented.
These can serve both as examples to compare questions for assessing their cognitive
level, or to initiate creation of new questions.
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Knowledge: The benefits from international trade include:
A. Increased world output of goods and services.
B. Greater efficiency in the use of the world’s limited

resources.
C. Higher national standards of living throughout the

world.
D. All of the above.

Comprehension: When tariffs are imposed, the losers include:
A. Domestic consumers and the domestic government.
B. Foreign consumers and domestic producers of import-

competing goods.
C. Domestic consumers and domestic producers of import-

competing goods.
D. Domestic consumers and foreign producers.

World output of goods and services increases with specialization
because:
A. he world’s resources are being used more efficiently.
B. Each country’s production possibilities curve is shifted

outward.
C. Each country’s workers are willing to work harder than

they did before specialization.
D. All of the above.

Application: Suppose the United States can produce 2000 cars or 2000 trucks.
Japan can produce either 2000 cars or 1000 trucks. In terms of
car production we can conclude that:
A. Japan has an absolute advantage.
B. The United States has an absolute advantage.
C. The United States has a comparative advantage
D. Japan has a comparative advantage. 

Farmers are most likely to be in favor of:
A. Free trade for fertilizer and crops.
B. Free trade for fertilizer but restricted imports of crops.
C. Restricted imports of fertilizer and crops.
D. Restricted imports of fertilizer and free trade of crops.
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Analysis: The elimination of import restrictions will: 
A. Alter the mix of output from export industries toward

domestic industries.
B. Redistribute income from import-competing industries

to export industries.
C. Alter the mix of output from export industries to

import-competing industries.
D. Redistribute income from domestic to foreign

producers.

These multiple choice questions were used directly or adapted from
questions the test banks accompanying Schiller’s The Macro Economy Today.

Recall that the exams did not include questions at the evaluation level of
cognition, but research has shown to me how that can be achieved.

Evaluation: A student was asked to do the following:  “Briefly describe the
economic rationale and impact of NAFTA in both the United States
and Mexico.”

As an answer the student wrote the following:

“NAFTA, The North American Free Trade Agreement, was
designed and implemented to take advantage of gains from free
trade. These gains are increased production in areas of comparative
advantage and increased consumption possibilities. It is expected
that there are adjustments in economies that go to free trade. The
goods and services that are produced without comparative
advantage will decline. It was expected that the U.S. would lose
manufacturing and agricultural producers and jobs especially with
fruits and citrus crops, but it would be made up in other areas. This
was the case when the U.S. had its largest economic expansion ever
in the 1990’s. This was also experienced in Mexico with great
growth, decreasing poverty, and diminishing illegal immigration to
the United States.”  

How would you judge the student’s answer?
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A. EXCELLENT (All statements about policy and outcomes
correct, answer is logically consistent, answer is complete)

B. GOOD (All statements about policy and outcomes correct,
answer is logically consistent, but is not clearly argued.

C. MEDIOCRE (Some statements about policy or outcomes
are incorrect and/or the answer lacks logical consistency
and/or is unclear.)

D. UNACCEPTABLE (Policies and outcomes incorrect, not
logically consistent, incomplete.)

CONCLUSION

Meeting course learning objectives and program level learning goals
certainly involves content acquisition, but professors also seek to determine whether
the student in the course can operate at higher cognitive levels.  Multiple-choice
exams can play a role in measuring both content and cognition in students especially
if they are designed to cover a range of skills showing varying cognitive skills.
Bloom’s taxonomy provides a great framework for evaluating, revising, and creating
multiple-choice exams that can assess such student achievement. 
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TEACHER CHARACTERISTICS
AND STUDENT LEARNING

Angela K. Dills, Mercer University
Dennis Placone,

Clemson University and Center for Economic Education

ABSTRACT

Establishing the determinants of teacher quality remains a difficult
empirical proposition. Prior research suggests that high school teachers’ subject
knowledge and, separately, teacher attitudes towards their subject affect student
learning. Because teacher knowledge and teacher attitudes are highly correlated,
we disentangle these two effects. We survey high school economics teachers and
their students primarily in South Carolina. Teacher economic knowledge positively
and significantly affects student learning; teacher attitude has little or no effect on
student learning. However, student test score gains of teachers volunteering to teach
economics courses are similar in size to the effect of a comparable increase in
teacher knowledge. Our results support interventions targeted towards enhancing
teachers’ understanding of economics and increased teacher control of course
selection.

INTRODUCTION

Teacher quality is an important input in student achievement although
identifying quality teachers is difficult without detailed panel data (Rivkin,
Hanushek, and Kain, 2005). Research in economic education finds that teacher
knowledge is one factor affecting student learning (Allgood and Walstad, 1999). In
addition, there is suggestive evidence that teacher attitudes matter (Marlin, 1999).

This paper addresses the question of what makes a high school teacher an
effective economics instructor. We consider two main possibilities: subject matter
knowledge and attitudes towards teaching economics.  The innovative feature is to
analyze both possibilities simultaneously with good measures of both teacher
knowledge and teacher attitude. We separate the two effects and compare the
importance of each.
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Attitudes and knowledge are highly correlated. For example, Schober
(1984) suggests that teacher achievement affects teacher opinions about economics.
Allgood and Walstad (1999), albeit with a small sample of 12 teachers, convincingly
demonstrate that a teacher’s economic knowledge or a teacher’s economic thinking
positively affects student performance. Marlin (1991) finds that students with
teachers more enthusiastic about teaching economics score higher on measures of
economic knowledge. Although Marlin controls for teacher experience in teaching
economics, he is unable to control for teacher knowledge. Given the correlation in
Schober (1984) between teacher attitudes and achievement, one could easily
interpret Marlin’s estimates on teacher attitudes as an effect of teacher knowledge
on student achievement. Relatedly, Boex (2000) provides evidence that college
instructors’ presentation skills, which includes enthusiasm for the subject, are more
important than their intellectual or scholarly nature in affecting student ratings of
teacher effectiveness. Untangling the two effects requires good information on
teacher knowledge, teacher attitudes, and student learning. 

To test these relationships directly, we survey high school economics
teachers and their students. Focusing on high school students is important in two
ways. First, seventeen states include economics as part of the high school curriculum
(NCEE, 2005). Second, the more economic knowledge students have, the more
likely they are to study economics in college (Ashworth and Evans, 2001). 

Teachers were assessed on their knowledge of and attitude towards
economics. Teachers tested their students at the beginning and end of an economics
course to provide a measure of student learning. We then estimate an empirical
model of student learning on teacher knowledge and teacher attitudes. We find that
better teacher knowledge consistently improves student learning. Teacher attitude,
as measured by a survey, has a statistically insignificant effect on student learning.
We explore an alternate measure of teacher attitude towards economics: whether the
teacher volunteered to teach the class. This revealed preference measure of teacher
attitude has a positive and statistically significant effect on student learning. The
effect size is similar to that of teacher knowledge. 

EMPIRICAL METHOD

We measure teacher knowledge and teacher attitudes towards economics
using standard assessments. We then test how teacher attitudes and teacher
knowledge affect student learning. We estimate Ordinary Least Squares (OLS)
regressions of the following for student i in class j:
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post-testij – pre-testij = γknowledgej + φattitudej + errorij

Our variables of interest are teacher knowledge and attitude. We expect both γ and
φ  to be positive and are interested in their relative magnitudes. To assess relative
magnitudes, we standardize the measures of teacher knowledge and attitude to
variables with a zero mean and a variance of one. The coefficients then reflect the
effect of a one standard deviation change in that teacher attribute.

Much of the discussion on specification of economic learning models
focuses on econometric difficulties in regressing the change in test scores (post-test
minus pre-test) on various attributes versus regressing the post-test score on the pre-
test score and various attributes (see Becker, et al, 1990 for example). Generally, the
change score method is preferred; we follow this preferred approach. 

Student gain scores are measured at the student level; teacher characteristics
are measured at the teacher level. The regressions thus include a large number of
observations for each teacher, exaggerating the amount of variation occurring in the
teacher characteristics. To account for the correlation among students in the teacher
characteristics, we cluster the standard errors by teacher. These regressions are
similar to regressions using teacher-level data, weighted by the number of student
observations.

DATA COLLECTION AND VARIABLE MEASUREMENT

We sent information packets to South Carolina teachers. We supplemented
a list of economics teachers provided by the South Carolina Council on Economic
Education with a search for social studies teachers at every high school in the state.
In total, we mailed out 468 surveys to South Carolina teachers in April 2006. A
second round of information packets were mailed in late July 2006 to 394 teachers.
A total of 52 teachers agreed to participate; 41 of these fully completed their
participation. Some teachers participated in more than one quarter or semester of
classes. Teachers were compensated $100 upon completion of participation; some
teachers were compensated more than once if they participated in more than one
quarter or semester. 

Teachers completed the Survey of Economic Attitudes (SEA) and the Test
of Economic Literacy (TEL) at the beginning of their economics course. The TEL
is a nationally-normed high school level assessment that provides a pre- and a post-
test. Teachers administered Form A of the TEL to their students at or near the
beginning of the course; they administered Form B of the TEL to their students at
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or near the end of the course. These two tests provide a measure of student learning
during the course. Teachers also completed a demographic survey. 

The first part of the SEA, the Attitudes towards Economics (ATE) section,
measures teacher attitudes towards economics using fourteen questions with
responses on a five-point Likert-type scale. These questions include such items as
“Economics is dull” and “I would be willing to attend a lecture by an economist”.
Respondents note whether they strongly agree, agree, are undecided, disagree, or
strongly disagree. Soper and Walstad (1983) provide reliability statistics for the
ATE. The Cronbach Alpha of 0.88 for the ATE demonstrates good internal
consistency; Soper and Walstad (1983) report a low standard error of measurement
of 3.18. 

Both assessments, the ATE and the TEL, are designed by the National
Council on Economic Education (NCEE). They are used frequently in student and
teacher assessment and research into student achievement (see, for example,
Dutkowsky, Evensky and Edmonds, 2006; Walstad and Rebeck, 2001; or the
summary in Becker, Greene, and Rosen, 1990). The raw scores for the teachers are
presented in Table 1. 

Table 1: Summary Statistics for Teachers and Students

Mean St. Dev. Min Max

Teacher Characteristics (N=41)

TEL 35.02 6.03 16 40

ATE 59.95 7.54 42 70

Students taking economics 47.46 33.09 2 178

Teacher's Age 46.69 10.27 25 60

Years Teaching 18.14 10.77 2 38

Years Teaching Economics 10.31 6.85 0 26

Percent of teachers that:

chose to teach economics 56.10%

are male 45.00%

are white 87.80%
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have their highest degree as:

Masters 77.50%

Doctorate 2.50%

Student Characteristics (N=1,946)

DTEL 3.89 5.54 -16.511 23.729

pretest TEL 17.48 6.65 -0.009 36.711

posttest TEL 21.37 7.28 3 40

On average, teachers preformed quite well on the TEL averaging 35
questions right out of forty. There is a large variance in teachers’ performance
ranging from 16, below the average for students who’ve taken some economics, to
a perfect score. The national average score on the TEL Form A for those without
economics is about 19 out of 40; the average score with economics is about 25 out
of 40 (Walstad and Rebeck, 2001).  

For positive statements about economics the ATE is scored as follows: if a
teacher strongly agrees with the statement, we assign that answer a 5; agrees
receives a 4; undecided, 3; disagrees, 2; and strongly disagrees, 1. For negative
statements, strongly disagrees receives a 5 and so on. Possible scores on the ATE
range from 14 to 70. Teachers averaged a score of 60 ranging from a low of 42 to
the maximum of 70. 

We consider an alternate measure of teacher attitudes: how teachers are
assigned to economics classes.1 About half of the teachers in our sample (56%)
report choosing to teach economics. The principal or department head assigned the
remaining teachers to the economics course. Teachers’ revealed preference in their
choice to teach economics may better reflect their enthusiasm in the classroom, as
compared to the survey-based measure of their attitude towards economics. 

The previous research on teacher attitudes focuses on enthusiasm. Marlin
(1991), for example, used a three-choice rating of teacher enthusiasm for teaching
economics in his study of teacher attitudes. Patrick, Hisley, and Kempler (2000)
discuss how more motivated teachers may be more effective at eliciting student
motivation and thus, student learning. In a psychology experiment, they manipulate
teacher enthusiasm and show that students lectured by more enthusiastic teachers are
more interested in learning more about the topic. 
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Choosing to teach economics is positively correlated with teacher scores on
the ATE. Teachers choosing to teach economics scored 62 on the ATE as compared
to a score of 57.4 for those assigned to teach economics. This reflects a little more
than one-half of a standard deviation change in the ATE. 

Table 1 also presents summary statistics of the sampled teachers’
characteristics. On average, each teacher submitted scores for 47 students. Many
teachers submitted scores for more than one class during a semester or for more than
one class during the school year. The average teacher is aged 46 with 18 years of
experience teaching and 10 years of experience teaching economics. Teachers in the
sample are 87.8 percent white and 44 percent male. 78 percent of the teachers have
a Master’s degree; one teacher has earned his doctorate.

The sampled teachers are somewhat comparable to an average social studies
teacher in South Carolina (authors’ calculations from the Schools and Staffing
Survey, 2003-2004). On average, South Carolina social studies teachers have taught
in public schools for 13.9 years and are 41 years old. Among these teachers, 88.8
percent are white and 58.3 percent male. 56.5 percent of South Carolina social
studies teachers have a Master’s degree. 

Our sampled teachers are somewhat older, more educated, and more
experienced than the relevant average teacher. Also, their high scores on both the
ATE and TEL reflect the higher than average interest these teachers expressed by
choosing to participate. We keep this revealed preference and sample selection in
mind when considering our results. 

Among our economics teachers, about 30 percent of them majored or
minored in economics. Fully one-third have attended an NCEE or state training
session. Again, this high rate of participation likely reflects the sampled teachers’
interest in economics and willingness to participate. More than 40 percent use
NCEE materials in their classroom. 

For the 41 teachers in our sample, we standardize their scores on the ATE
and TEL to be mean zero and variance one. This allows us to compare the
magnitudes of the effects of these teacher qualities on student learning. 

Teachers used Form A of the TEL to assess students at the beginning of the
course and Form B at the end of the course. We convert the Form A scores to a scale
comparable to Form B as suggested by the TEL Examiner’s Manual. The outcome
of interest is student learning: the change in students’ scores between the post-test
and the pre-test. On the pre-test, students, on average, correctly answered 17 of the
40 questions; on the post-test, students, on average, correctly answered 21 of 40
questions. In our sample, both the pre-test and post-test scores are lower than the
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national averages. The national average on Form A of the TEL for students without
economics is 19.05; the national average on Form B of the TEL for students with
economics is 25.74 (Walstad and Rebeck, 2001). The average change in test scores
for our sample was 3.89. The difference in the national averages is about 6.7
questions. The gain in test scores is also smaller than the difference between the
national averages. 

SPECIFICATION ISSUES

Other factors may affect student test scores. Becker, Greene, and Rosen
(1990) enumerate the factors that may affect student learning of economics: student
ability, teacher ability, course work, technology, demographics, and time usage.
Females and blacks tend to perform worse than males and whites in college
economics courses (Dynan and Rouse, 1997 and Borg and Stranahan, 2002). Class
size may affect student performance (Arias and Walker, 2004). The evidence on the
effects of instructor gender is mixed: Robb and Robb (1999) and Dynan and Rouse
(1997) find no effect of gender on college student performance while Ashworth and
Evans (2001) find that female secondary teachers increase the likelihood of studying
economics in high school. Klopfenstein (2005) finds same-race effects for black
math achievement.

Our limited sample of teachers precludes including many control variables
including teacher characteristics. In addition, data limitations prevent us from
including student characteristics such as race or sex.2 For these exclusions to bias
our estimates, the omitted variables must be correlated with teacher knowledge or
teacher attitude. For example, if better prepared or more positive instructors are
matched with students who learn more quickly, this would bias our estimates
upwards. 

We check for indications of this bias although the limited sample size makes
it difficult to control for those factors. We split the sample at the median of the
teachers’ TEL scores. The average student’s pre-test score for the top half of
teachers is 18.62 versus 16.03 for the average student of a teacher from the bottom
half. Students with higher pre-test scores tend to be taught by higher scoring
teachers. Students with higher pre-test scores also tend to be taught by teachers with
higher ATE scores. For a teacher scoring in the top half of teacher’s attitudes, the
average student pre-test score is 17.80; for a teacher in the bottom half, the average
is 16.95. 
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If students that would have learned more regardless of their teacher are
matched with higher quality teachers, this selection would bias the effects of teacher
quality upwards. In this case, we observe that students with higher pre-test scores
learn less, on average, than students with lower pre-test scores. The above median
student experienced test scores gains of 2.6 points; the below median student gained
5.4 points. This difference isn’t driven by ceiling effects; less than one percent of
students correctly answered 38 or more of the 40 questions on the post-test. 

Since high pre-test students are matched with higher knowledge teachers
and high pre-test students have smaller growth in their test scores, this suggests that
teacher-student matching may bias downwards the estimated teacher knowledge
coefficients. This makes it more difficult to find effects of teacher knowledge on
student learning. Similarly, teacher-student matching may bias downwards the
estimated teacher attitude coefficients. 

Higher pre-test scoring students tend to be matched to teachers who did not
volunteer to teach economics, although this difference is not statistically significant.
The average student pre-test score for a teacher choosing to teach economics is
17.32; the average student pre-test score for a teacher assigned to teach economics
is 17.67. As lower pre-test students tend to have higher gain scores and are matched
with assigned teachers, this suggests a potential downward bias in the coefficient
estimate on whether a teacher choose to teach economics. 

RESULTS

Figure 1a presents mean changes in student test scores by teacher scores on
the TEL and ATE. Teachers with below median scores on the TEL taught students
with smaller gains in test scores; this difference is statistically significant. Among
the lower knowledge teachers, having a higher score on the ATE does not correlate
with higher student test score gains. Among the higher knowledge teachers, a higher
score on the ATE correlates with somewhat high student test score gains. 

Figure 1b uses whether a teacher volunteered to teach economics as the
measure of teacher attitude. Teachers choosing to teach economics taught students
with significantly larger gains in test scores; this difference is statistically
significant. This difference is particularly large for the lower knowledge teachers.
However, for both the below and above median knowledge teachers, choosing to
teach economics corresponds to statistically significantly higher test score gains. 
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Figure 1a: Mean changes in test scores by teacher characteristics
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Figure 1b: Mean changes in test scores by teacher characteristics

We estimate a regression of the change in student test scores on the
teachers’ standardized TEL and ATE scores. Regressions include 1,946 students in
41 teachers’ classes. Table 2 presents the results. 
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Table 2: Regression results of students' change in test scores on
teacher ability and attitude toward economics

(1) (2) (3) (4) (5) (6) (7)

students' change in test scores on TEL

teacher's TEL
 (z-score)

0.753* 0.655* 0.684* 0.602 0.681* 0.671* 0.645*

(1.79) (1.72) (1.71) (1.58) (1.72) (1.77) (1.80)

teacher's ATE
 (z-score)

0.395

(0.71)

teacher chose 1.477** 1.131* 1.110* 1.202* 1.169 0.223

(2.09) (1.69) (1.70) (1.80) (1.68) (0.43)

male teacher -1.165* -1.142* -0.765 -0.645 -0.392

(-1.78) (-1.78) (-1.17) (-0.85) (-0.59)

white teacher 0.0681 -0.0203 -0.755 -0.851 -1.013

(0.070) (-0.019) (-0.67) (-0.76) (-0.87)

years teaching
economics

0.0583 0.0561 0.0548 0.0734**

(1.30) (1.30) (1.28) (2.03)

economics major
or minor?

-0.906 -0.933 -1.264

(-1.30) (-1.31) (-1.56)

Attended NCEE
or state training?

0.390 -0.518

(0.43) (-0.71)

Use NCEE
materials?

2.266***

(3.17)

Constant 3.713*** 2.957*** 3.613*** 3.039** 3.717*** 3.667*** 3.530***

(9.57) (7.08) (3.83) (2.67) (3.28) (3.42) (3.12)

R-squared 0.02 0.03 0.04 0.05 0.05 0.05 0.07

Robust t statistics in parentheses. Standard errors clustered by teacher. * significant at 10%; **
significant at 5%; *** significant at 1%. There are 1,946 students in the sample and 41 teachers.

The first column presents the estimates of changes in test scores on the
standardize measures of teacher knowledge and teacher attitude (from the ATE).
This column echoes the pattern shown in Figure 1a. Students taught by a teacher
with economic knowledge one standard deviation above the mean experience an
additional increase in their scores of a little less than one question. This reflects
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about a 19 percent increase in their test score growth. Controlling for teacher
knowledge, teacher attitude as measured by the ATE has a small and statistically
insignificant effect on student test scores. The effect of teacher knowledge is about
twice as large as that of teacher attitude. These estimates support previous research
showing that teacher knowledge increases student learning. The existing evidence
on teacher attitudes is thin; our evidence merely corroborates its thinness. Given the
potential upward bias on teacher attitude, there seems to be little effect of teacher
attitude, as measured by the ATE, on student learning. We focus on the other
measure of teacher attitude in the remaining regressions. 

The second column presents the estimates of changes in test scores on the
teacher’s score on the TEL and an indicator variable for whether the teacher chose
to teach economics. The second column echoes the pattern shown in Figure 1b.
Teachers with more knowledge correlate with increased student learning; teachers
choosing to teach economics also correlates with increased student learning. The
effect of a teacher volunteering is large, amounting to about 38 percent of average
student test score gains. Both teacher characteristics have a statistically significant
and economically relevant effect on student test score gains. 

The third column adds two teacher demographic variables to the
specification: an indicator for whether the teacher is male and one for whether the
teacher is white. Male teachers experience significantly lower gains than female
teachers with their students gaining, on average, one less question from pre-test to
post-test. The coefficient on the white dummy variable is small, positive, and
statistically insignificant. Further, including these demographics has little effect on
the estimated coefficients on teacher knowledge or whether the teacher chose to
teach economics. 

We include teacher experience in column (4).  Teachers with one more year
of experience teaching economics have students with slightly higher test score gains;
the estimate is small, less than a tenth of a question, and statistically insignificant.

The last three columns of Table 3 include controls that may reflect teacher
knowledge or teacher interest in economics. In column (5) we include an indicator
variable for whether the teacher was an economics major or minor in college.
Economics majors or minors instruct students with smaller test score gains, although
the difference is not statistically significant. Column (6) adds an indicator variable
for whether the teacher has attended a NCEE or state training session. Column (7)
includes an indicator for whether the teacher uses NCEE materials in his or her
class. The coefficient on the training session is statistically insignificant and changes
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sign when we include the materials indicator variable. The students of teachers using
NCEE materials experience much greater test score gains.

Including the last set of variables, particularly the use of NCEE materials,
reduces both the magnitude and the significance of the estimated coefficient on
whether the teacher chose to teach economics. These two variables are highly
correlated (ρ = 0.5342): teachers who chose to teach economics also typically use
NCEE materials in their classroom.3 Further, including these variables reflecting
economics training reduces the magnitude and the significance of the male variable;
any effect of teacher gender appears to be driven by their varying backgrounds in
economics.

CONCLUSIONS AND POLICY IMPLICATIONS

We find that teacher knowledge of economics is an important determinant
of student learning. Teacher attitude towards economics, as measured by the first
part of the Survey of Economic Attitudes, has a small and statistically insignificant
effect on student learning. However, teachers choosing to teach economics
experience greater student test score gains. These volunteering teachers likely
exhibit more enthusiasm for the class. The effect of teachers choosing to teach
economics and teacher knowledge of economics are similarly sized and statistically
significant. 

These results suggest two things. First, that much emphasis, correctly, has
been placed on improving teacher economic knowledge and providing teachers with
materials for their economics courses. We encourage the continued development of
materials and interventions focused on improving teacher understanding of
economics. In fact, the use of NCEE’s materials appears to improve student
learning. Second, reconsidering how teachers are assigned to economics classes may
alleviate some of their anecdotal distress and improve student learning in the
process. To the extent allowed by resource constraints, our results suggest that
allowing teachers increased control over the classes taught could improve student
outcomes. 
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ENDNOTES

1 We thank Andrew I. Kohen for this suggestion.
2 To satisfy the Institutional Review Board’s Exemption category for human subjects

research, we opted not to collect student-specific demographic information. A full
IRB review outside the exempt categorization would require parental permission
for each student, likely further limiting our sample size. 

3 Results are qualitatively similar when using the teachers’ ATE scores instead of the
teacher chose variable.
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STADIUM ATTENDANCE FOR
BASEBALL: A CASE STUDY

Nancy J. Burnett, University of Wisconsin 
Lee Van Scyoc, University of Wisconsin

ABSTRACT

We examine stadium attendance for the Mallards baseball team, a non-
professional, summer collegiate baseball team in the Northwoods League in
Madison, Wisconsin. Not only can this analysis be used in a principles course as a
case study to explain demand shifts in a perfectly elastic supply situation, it also
highlights this team’s  unique experience of having game attendance at a rate far
exceeding any other team in their league, even surpassing that of some major league
baseball teams. 

INTRODUCTION

Teaching a principles of economics course leads inevitably to an exposition
of Supply and Demand curves and their elasticities. Many of us struggle to find real
world examples of the polar cases (perfectly elastic demand or supply) to present to
our students. In this paper, we have developed a model using perfectly elastic supply
in stadium attendance for a local non-professional baseball team. The team under
consideration here is the Madison Mallards, which played for the first time in 2001.
Since that time, it has never raised seating prices and does not sell out games,
leading to a situation of perfectly elastic supply (see Figure 1). 

This example becomes one in which we examine Demand shifts to
determine the increases in attendance. Among the demand factors that could be
pushing demand, the traditional factors of area population, area income, alternative
choices, and ‘tastes’ need to be considered. As the prices of alternative
entertainment choices did not vary in any significant way in this area during the time
period in question (we looked at movie ticket prices, etc), that option was discarded.
When we look at ‘tastes’ for entertainment, a class discussion regarding why a
person (or family) might choose an amateur league baseball outing over other
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choices can be quite illustrative. For example, choosing an outdoor entertainment
choice over, say, going to a museum or library, the weather could play a role. Sports
economics would suggest that the team’s performance record should matter, as most
people prefer to witness a ‘win’ by the home team rather than otherwise, so team
stats should have some explanatory power here. Though if that were the only factor
pulling fans, one would expect that higher levels of play in the Major leagues would
draw substantially larger crowds. Our analysis of their attendance explores not only
the traditionally accepted explanatory variables of performance outcome and
environmental concerns common in Sports Economics (see Rasher, 1999 among
others) but also the various types of promotions used by the Mallards’ ownership to
attract patrons. It is this last set of variables that prove to be highly instrumental in
explaining attendance – providing a lesson perhaps for other teams. 

Figure 1
Madison Mallards S&D



31

Journal of Economics and Economic Education Research, Volume 9, Number 3,  2008

We examine the attendance record of this team since its inception in 2001
and covering the subsequent 153 home games. We note that this team’s experience
is unique in that it attracts fans far in excess of what would be expected given the
league in which it plays. Indeed, Figure 2 shows the Mallards attendance figures
compared to the league average. 

Figure 2:  Madison Mallards vs. League Average Attendance, by year
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Source: Northwoods League, Media Guide, Johnson Printing, 2006.

It is clear that there is something unusual about the Mallards as a team and
their ability to draw fans. Therefore, this paper examines the Mallards Stadium
attendance not only as a stand-alone example of Supply and Demand, but through
the precepts of Sports Economics, a fast-growing sub-discipline of economics that
has set precedent for studies of this type. 

The Mallards play in the Northwoods League of non-professional Spring
season baseball using college level players seeking to gain league experience
without losing their collegiate eligibility. This team plays in its own stadium near
the community of Madison, WI, a community far from bereft of entertainment
possibilities. Indeed, there are even two local farm teams (the Beloit Snappers and
the Wisconsin Timber Rattlers) that play within a reasonable driving distance of the
Mallards, as well as the Milwaukee Brewers major league team. In 2001, the
Northwoods League consisted of seven teams besides the Mallards. Since then, the
league has expanded twice, for a total of twelve teams. Within this league, the
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Mallards are something of an attendance phenomenon. During their first year in the
league, they had their smallest total attendance, placing them at the midway point
in the entire league. By their second season they were the top drawing team, and
continue to rank with the highest overall attendance in their league (Figure 1,
above). Compared to professional teams, the Mallards’ attendance is not
insignificant either. For example, out of the more than 175 affiliated farm teams that
played in 2005, the average attendance of the Mallards was higher than that at all
but the top 35 teams, putting them in the top 20% of those teams. Further, the
Montreal Expos’ (National League, professional team) average attendance was
9,356, while the Mallards actually had a few games with higher attendance. Indeed,
there were several games played by the Montreal Expos with lower attendance than
the Mallards in 2004.1 

LITERATURE

We investigate the demand for home games using attendance figures for a
team that has, by all measures, defied the standard wisdom that would predict low
fan turnout, as its win/loss record is hardly anything unusual. Indeed, the team we
are studying regularly has stadium attendance that  has occasionally topped  that of
Major League Baseball Teams. How they manage to achieve such a feat, is the goal
of this paper beyond just estimating just another stadium attendance model. We
follow the existing literature for such models before widening our approach to the
inclusion of other variables.  

Current work in the field of Sports Economics includes primarily
econometric studies that examine the ‘usual suspects’ to explain fan turnout: age of
stadium, quality of play, price of ticket, and so on tend to be the factors in question.
For instance, Rascher (1999) shows such a model using winning percentages as well
as environmental components (day of the week, temperature, area economic data,
etc.) and finds that he is able to explain between 60% and 75% of attendance for
Major League baseball during a single season (1996). This study, being league-
wide, means that regional variances in fan tastes had to be taken into consideration,
done mainly by Rascher using racial composition of the various localities. This is
somewhat troublesome as there can be wide differences in fan loyalty in any
particular location due to other effects than race. Indeed, in our study we find that
game attendance rises from an average of just over 1,500 fans per game in 2001 to
over 5,700 fans per game in 2005 with essentially no change in racial composition
of the area. 
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Butler (2002) estimates baseball demand using more definitive
environmental data than Rascher. We follow Butler’s precedent using precipitation
as well as temperature and day of the week rather than just ‘weekend’ or ‘night’
game dummy variables. 

Clapp and Hakes (2005) concentrate their analysis on stadium amenities,
age in particular to explain fan demand. They find, using data over more than a half
century, that new stadium effect wane quickly, on average diminishing to nearly
zero in as little as two years. Our data demonstrates such dramatic increases in
attendance, in a continuing upward direction over the entire sample period, that we
feel fairly confident in omitting stadium age from our model as Clapp and Hakes
suggest that any affect from stadium age would be long gone by the time our sample
concludes. 

Coates and Harrison (2005) examine the effects of an outcome based quality
assessment on the part of fans for baseball stadium seat demand. They find that team
success is a large factor in attendance, regardless of such extraneous negative
influences (such as the strike in Major League Ball) or stadium age. 

For some time, authors have sought to explain game attendance with the
‘star’ factor or with the potential for a closely played game by looking at probability
of winning a given game or stats on a particular player or on the game starters. For
instance, Scully (1989) finds that games that have a high probability of either team
winning even when the home team was likely to win had lower attendance than those
games that were thought to be more closely contested, prompting leagues to institute
rules that had the outcomes of ‘leveling the playing field’ as it were. Several authors,
studying the demand for sports attendance, use team quality in one way or another
for analyses of this sort. We follow many of these by looking at quality with an
outcomes based assessment method such as that used by Scully (1989) or Coates
and Harrison (2005). 

Leventhal (2000), attempts an overview of generalized factors of fan
loyalty. For instance, the quality of play comes into question when the winning
percentage or existence of ‘stars’ in such studies as Butler (2002) and Zimbalist
(2003). Other studies look at ticket pricing such as those by Noll (1974) and Salant
(1992), though in our study ticket pricing did not vary over the period and, given
rather low levels of inflation, alternative entertainment pricing also didn’t vary
enough to warrant inclusion in our model. Research in the field has a long standing
tradition of assuming some unmeasurable motivation behind fan loyalty determined
by locality or tradition that makes comparisons across teams less empirically
satisfying than theory might suggest (see particularly Porter (1992) and Owen
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(2003)). Because of that, we feel that our case study approach is justified rather than
attempting to examine the disparities across teams within the relatively small league
within which the Mallards play.   

From our initial perspective, we realized that many of the standard
explanations of fan turnout would not prove particularly satisfactory with the team
we are studying. The Mallards are a member of the Northwoods League that uses
only college players: In order to maintain NCAA (college) eligibility, these players
cannot receive pay of any kind. Hence, the level of play is not the same as one
would expect out of a professional league. Indeed, there are few if any with name
recognition of any sort (they recruit players nationwide, rarely relying on local
teams for players so that the fans are not previously acquainted with ‘stars’ or even
‘personalities’ of the players). They play at Warner Park, a stadium that is neither
new nor luxurious by any standard.

Furthermore, the entire roster changes from year to year so that there is little
‘carry-over’ due to any particular player or line-up. Ticket prices for the Mallards
are very near to those charged by any other team of similar caliber and exceed those
of local college or high school teams that would provide ‘home town heroes.’
Indeed, we have ascertained that the Mallards do very little direct advertising other
than having a web presence and hosting local radio personalities in order to gain
word of mouth excitement. Therefore, we realize that several of the standard
measures of player or team quality are likely to even be recognized much less act as
impetus for attendance.

So, what is different about the Mallards? Why do they so far exceed the
attendance figures of every other team in their league and of teams in leagues far and
away superior to them? We decided to investigate all of the standard variables so
often at the center of studies of this type, but also to add in several other
environmental factors. 

DATA

Our data comes from the all home games of this team, since its inception in
2001 through 2005 (about half of all games played by this team). Game attendance,
box scores, and other game data were provided to us directly from the head office
of the Madison Mallards. Table I shows the area data on population and median
income, along with game day average for weather. 

After speaking at length with the management of the team, we came to
believe that the Mallards offered something rather special, perhaps even unique, in
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baseball. One of the most eye-popping examples of this difference was demonstrated
by a picture found on their website. In this picture, the game was in progress (a
game they ultimately lost by the way) and the aerial photograph showed an area of
the ‘picnic’ lawn (an area where fans can lounge in the grass) full of fans – but the
area has absolutely NO view of the ongoing game. Given that there is free admission
to nearby community parks, why would these people pay to sit on the grass in a
baseball stadium where they can’t even view the game? The Mallards have made a
mission of providing family oriented entertainment at reasonable prices. They make
a practice of offering different promotions (give-aways or other attractions like
autograph signing by visiting celebrities, fireworks etc.) at every game, quite unlike
the standard practice of occasional promotions practiced by their competition. 

The management is extremely sensitive of the family environment of their
stadium and offers several areas for families to enjoy their time during the game.
They even offer a family special area with a one price admission to a play area. The
owner suggests: 

Here you come in,  have a playground, (free) bounce house, speed pitch,
chase foul balls and get a free hot dog, sit on the hill to talk and run -  not
to watch baseball.  So your 4 year old has something to do.  So why go
here instead of a park? Take an inning off or so? Yes, especially for the
standing room only nights. Watch for a while and then run around on the
hill. 50-100 kids chasing foul balls behind 1st base, so it is a social thing,
more than at a park. Have a tail gate area – 2 tents behind first base with
up to 1,500 people, reserved seats, pregame food and some groups never
left the tent – stayed and talked rather than go to seats - - can hear the
game/announcer who is funny. Just people watching is fantastic – coeds
to families, to little kids to retired people… my wife loves to watch
people. No better place to do it than right here.

Clearly, this team offers something special, something other than ordinary
baseball viewing. We delved into this difference during a series of interviews with
the owner and other head office personnel. Even during the first such interview, it
became clear that the Mallard’s approach to team promotion was different from
other teams. Though there was, and is, emphasis placed on winning games and the
division, management is highly cognizant of their fan base. They have a very strong
belief that many of their fans come out to the park for family entertainment, all
inclusive of the game as well as all entertainment during, before, and after the
players take the field. To quote: 
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Baseball is number one, family atmosphere, affordable tickets,
giveaways…one not more important than anything else. If it was just
baseball, we would only have 1,000 a night, but we do other things while
keeping baseball important.  

Indeed, management has a very clear idea of which promotions are most
successful. They believe that the family oriented promotions, such as fireworks,
give-aways exclusively for children (such as bats, hats, or dolls, for instance) draw
more fans than those more adult oriented promotions.  When asked about the most
popular forms of non-baseball entertainment, the immediate response was

Fireworks… everyone else says so too and they are right. First show in
June for Fireworks, looking at Friday and Saturday (first fireworks) had
twice as many as Friday when usually we do better than Friday…

The more adult oriented promotions include some of the standard adult fan oriented
give-aways (such as calendars, schedules, beer steins, etc.) as well some very creative
schemes that may well have been unique to the Mallards. One such promotion was the give-
away of one free nose job, though management was quick to assure the authors that this
particular give-away was actually quite well received, there were other promotions that did
not work as well. According to the owner, the worst promotion was “Singles night. Sell seats
to opposite sexes every other seat. Didn’t work…” In that particular scheme, all of the single
seat sales for that game were doled out on the basis of the gender of the purchaser (not only
a logistical nightmare, there were too few women buying individual seats, making many male
purchasers end up with less desirable seats).  Perhaps because of these opinions, the team has
been offering more family oriented promotions in recent years. Our model tests whether this
bias toward family promotions does indeed draw more fans than the more adult oriented
promotions. 

Management also provided information on the cost of promotions, the most
expensive single ‘item’ being fireworks at approximately $2,000 for one event. Fireworks,
as well as other promotions that act as localized ‘public goods’ (such as musical acts), were
valued simply as their total cost. Individual give-aways were valued individually, with the
number of items given, to determine the total cost. For instance Bobble-head dolls being the
priciest per item (at approximately $4 each), but they were only awarded to the first 250 fans,
making the total cost of the give-away for that game $1,000. Several of the give-aways were
free to the team, as they were provided by sponsoring entities, those too were valued at the
price to the sponsor rather than to the team. Our study includes both the type of promotion
offered at each game (family oriented or not) and the value of these promotions. Season
summaries of these variables can be found in Table II. 
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Table I:  Environmental Data – by Season, 2001 to 2005

Season Median Income CMSA
Population

Weather
(Rainfall,
gameday
average)

Temp
(gameday,
average)

2001 50,776 212,099 .19 68.5

2002 51,230 215,414 .03 71.4

2003 52,216 217,815 .11 68.7

2004 52,918 220,332 .10 67

2005 53,582 223,131 .03 70.4

Source: Weather and Temperature from National Weather Service Forecast Office,
www.crh.noaa.gov/mkx/climate. 
Population and Income data from the US Census Bureau, County QuickFacts,
www.quickfacts.census.gov/qfd/states

Table II:  Promotion Characteristics by Season – 2001-2005

Promotion Characteristic 2001 2002 2003 2004 2005

Average Promotion Cost 215.59 384.39 1172.48 1906.47 1372.06

% Family Centered Promotion (KID
PROMOTION)

.41 .48 .57 .4 .53

Source: Madison Mallards home office.

METHODOLOGY

Following past research in this field, we first look at a model of attendance very like
those done previously: One assuming the demand for a particular game has the form 

ATT= aTh + bTa + other 

Where ATT is the attendance of home games, T is a vector of talent variables, h being the
home team and a being the away (or visiting) team. We expect that a>b as fans are more
likely to both be more aware of the home team’s talent and be more likely to attend based on
the quality of the home team than the visitor, all else being equal. Rather than using a sort
of ‘past predicts the present’ sort of talent analysis, we employ an outcomes based fan
analysis. For instance, rather than looking at a composite variable of earned errors over the
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past several games, we look at the string of wins over the most recent games and the current
game outcomes. In that way, we are presuming that fans are capable of gathering and
assimilating information in a more accurate way than impressing, say, a Koyck distributed
lag on the data. We also look at the square of the difference between the talent variables
across teams, as is also common in the literature. The other variables included in our work
include those common in the literature, such as game and environment characteristics such
as day of the week, temperature (deviation from expected norm), precipitation, area
population and area median income. This leads to Model 1. 

Model 1: 

ATT = CONSTANT +  a ABh +  b Rh +  c Hh + d BIh + eEh + f IPh + g ERh

+ h ABa + i Ra + j Ha + k BIa + l Ea + m IPa + n ERa + o (ABh-ABa)2 + p
(Rh-Ra)2  + q (Hh-Ha)2 + r (BIh-BIa)2 + s (Eh – Ea)2   + t (ERh-ERa)2 + u (IPh-
IPa)2 + v WINSTRING + w WIN + x WTR + y DEPARTURE + z
AVERAGE + aa  POPULATION + ab INCOME + (error)

Where lower case letters are coefficients, subscripts refer to either the Mallard (h) or visiting
team (a). Table III summarizes the variables. 

Table III:  Variables

Variable Name Definition Variable Name Definition

ATT Stadium Attendance CONSTANT Constant term

AB At bats WINSTRING Length of winning string
do date (if last game lost,
=0)

R Runs WIN =1 if Mallards win

H hits WTR Weather: Precipitation
amount

BI Runs batted in DEPARTURE Departure from expected
temp

E Errors AVERAGE Average temp. expected

IP Innings Pitched POPULATION Area population

ER Earned runs INCOME Area income

KidPromo =1 if promotion family
oriented

DBL =1 if game double header

Day =1 if Monday, =2 if
Tuesday, etc.

NETSCORE =Mallard Runs – Visitor
Runs

WINLASTGAME =1 if last game won
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In our second model, we include variables that further define the game
environment – in particular those identified by management as being important to
attendance (as specified during the interview process). Far from being such variables
as those already identified in the literature, such as ‘star power’ of various players,
or team history, management highlighted game promotions. These promotions are
broken down into those oriented specifically for family/child entertainment versus
adult oriented promotions. Family or child oriented promotions were such things as
bats for kids under 14, bobble-head dolls for kids under 14, or fireworks shows at
the game’s conclusion. Adult oriented entertainment, included such events as live
music performed in the stadium, or ‘singles night’ (where seats were sold to
opposite sexes in alternating order), or even ‘nose job night’ (winner gets all
expense paid nose job).  Furthermore, we identified the approximate cost of each
promotion, from the point of view of the fan.2  Hence, we come to model 2. 

Model 2:

ATT = CONSTANT + a ABh + b Rh + c Hh +d BIh +e Eh +f IPh +g
ERh + h ABa + i Ra + j Ha + k BIa + l Ea + m IPa + n ERa + o (ABh-
ABa)2 + p (Rh-Ra)2  + q (Hh-Ha)2 + r (BIh-BIa)2 + s (Eh – Ea)2    +  t
(ERh-ERa)2 + u (IPh-IPa)2 + v WINSTRING + w WIN + x WTR +
y DEPARTURE + z AVERAGE  +  aa POPULATION + ab
INCOME + ac KIDPROMO + ad PROMOCOST + ae DBL+ a f
DAY +(error)

Where variables are as described in Table III. 

To determine just how important the stadium specific promotions are, we
develop Model 3. It is designed around the casual fan who may know little about
baseball and is only looking for an outing. Hence, we limit the explanatory variables
to those that might be easily discovered to a non- aficionado, removing all of the
talent variables but including the environmental and promotional variables as well
as the ‘winning string’ (based on the concept that even casual fans love a winner).
This brings us to Model 3.
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Model 3:

ATT = CONSTANT + a WINSTRING + b WIN + c WTR +d
DEPARTURE + e AVERAGE + f POPULATION +g INCOME +
h KIDPROMO + i PROMOCOST + j DBL+ k DAY + l
NETSCORE + m WINLASTGAME + (error)

Where variables are as described in Table III. 

RESULTS

Our three models’ results are shown in Table IV. Of particular interest is the
fact that Model 3, without any talent variables at all, can show significance
stunningly close either of the other two models, bearing out the Mallard’s own
perceptions of the importance of the environmental variables in determining fan
attendance. Model 1, using the traditional variables dealing with team performance
meets the explanatory power suggested by Rasher (1999) of 60-75%, and the
inclusion of data on team promotions pushed the explanatory power significantly
higher to nearly 80% in Model 2. A brief look a the F statistic of these models
suggests that eliminating the vast preponderance of the performance variables does
little damage to the resulting explanatory power of the regression, flying the face of
traditional Sports Economics analysis but fully supporting the team’s management
perspective of the importance of promotions to attendance. 

Table IV:  Empirical Results 
Dependent = ATTENDANCE

 Variable Model 1 Model 2 Model 3

Constant -87741
(t=12.1)

-82056
(t=12.31)

-81710
(t=-12.84)**

ABh -56.38
(t=.11)

-60.04
(t=1.14)

Rh 276.18
(t=1.69)

197.89
(t=1.34)

Hh -48.09
(t=.78)

-32.61
(t=.582)
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BIh 26.14
(t=.14)

81.07
(t=.47)

Eh -95.59
(t=.97)

-90.10
(t=.941)

IPh 697.11
(t=2.19)**

665.88
(t=2.34)**

ERh .712
(t=.006)

7.70
(t=.072)

ABa -19.13
(t=.325)

-3.16
(t=.060)

Ra -64.06
(t=.423)

-50.11
(t=.37)

Ha 75.52
(t=1.11)

56.05
(t=.91)

BIa 15.37
(t=.098)

38.84
(t=.28)

Ea -10.11
(t=.098)

-19.18
(t=.206)

IPa -342.25
(t=1.097)

-306.73
(t=1.27)

ERa -188.90
(t=1.377)

-186.19
(t=1.51)

(ABh -ABa)2 -1.14
(t=.22)

-3.39
(t=.723)

(Rh-Ra)2 23.75
(t=1.86)

21.47
(t=1.87)

(Hh  - Ha)2 -4.30
(t=.681)

-3.95
(t=.684)

(BIh-BIa)2 -18.22
(t=1.22)

-15.05
(t=1.14)
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(Eh-Ea)2 17.438
(t=.586)

31.89
(t=1.19)

(ERh-ERa)2 -3.864
(t=.368)

-.221
(t=.023)

(IPh-IPa) 2 102.05
(t=2.09)**

95.424
(t=2.18)**

WinLastGame 55.06 
(t=.313)

WIN -715.62
(t=1.566)

-574.21
(t=1.402)

76.41
 (t=.281)

NetScore 23.01 
(t=.69)

Population -.249
(t=1.332)

-.262
(t=1.56)

-.160
(t=1.01)

Income 2.582
(t=3.55)**

2.53
(t=3.87)**

2.10
(t=3.47)**

KidPromotion -279.33
(t=1.54)

-298.94
(t=1.79)

PromoCost .298
(t=5.35)**

.293
(t=5.53)**

DBL -138.442
(t=.417)

-245.49
(t=.74)

Day 51.27
(t=.974)

73.8
(t=1.57)

AVG 144.74
(t=3.85)**

141.81
(t=4.196)**

143.62
(t=4.44)**

DEP -187.88
(t=4.69)**

-169.72
(t=4.72)**

-171.11
(t=5.1)**

WTR -167.96
(t=.669)

-131.55
(t=.587)

-175.52
(t=.805)
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WinString -39.91
(t=.592)

-70.78
(t=1.17)

-40.78
(t=-.705)

Adj R2 .746 .799 .793

F 16.851** 19.786** 45.833**

Absolute value of T score of unstandardized coefficients reported 
** implies significance at 95%. 

Closer inspection of model results clearly shows that the only performance
variable that mattered here was IP (innings pitched) – with longer games showing
more attendance. We can infer that fans were able to riddle out which games would
be close even before the game was played so that they would attend those longer,
more closely contested games (just as Scully, 1989 predicted).  Not even winning
the game or the most recent winning streak was significant. 

What was significant in all three models was the average expected
temperature at game time, with higher temperatures bringing in more fans (this may
indicate that baseball attendance is simply higher in July when temperatures are
likely to be higher than during other months). The departure from average (DEP) on
specific game days was also significant, meaning that especially hot or especially
cold temperatures (as a departure from expected average) did drive attendance,
suggesting the conclusion that when temperatures were over-warm attendance
lagged (as there is a positive coefficient on DEP). Oddly, the advent of rain did little
to deter fans from attending games. 

Just as management suggested, the cost of the promotions mattered with
higher cost events brining in more fans. Contrary to what management thought,
however, our research suggests that “kid” promotions were no better received than
those aimed at adults. In sum, Model 3, using only the barest of the performance
data (winning streak, score, and wining the most recent game) but including
promotion data actually outperformed Model 1 (the traditional model using the
largest array of performance data but no data on promotions). It is clear that for this
team, the value of the entertainment provided by attending a game is not limited to
the level of skill of the baseball players or even how the team fares against other
teams. Fans appear to value this experience for what it can bring to them as an
entertainment package. 



44

Journal of Economics and Economic Education Research, Volume 9, Number 3, 2008

The final lesson this could bring home to students in an introductory course
is that demand for this type of entertainment is driven by such traditional factors like
area income but also that elusive ‘taste’ variable. In this particular case, warm
weather games (that were not hotter than expected) and the closely contested games
(more innings pitched) were more likely to be those attended by fans along with
those games with the best promotions (fireworks being the most expensive, so the
biggest draw). 

ENDNOTES

1 From mtlexpos.tripod.com/attendance.htm, the official home web site for the
Montreal Expos. 

2 Data was gathered as to whether promotions were sponsored by corporations or not,
but this did not affect fan response. 

REFERENCES

Butler, M. R. (2002). Interleague play and baseball attendance. Journal of Sports Economics,
3(4), 320-334.

 Clap, C. M. and Hakes, J. K. (2005). How Long a Honeymoon? The Effect of New
Stadiums on Attendance in Major League Baseball. Journal of Sports Economics,
6(3), 237-263. 

Coates, D and T. Harrison (2005) Baseball Strikes and the Demand for Attendance. Journal
of Sports Economics, 6(3), 282-302. 

Leventhal, J. (2000). Take me out to the ballpark. New York: Black Dog and Leventhal. 

Noll, R. G. (1974). Attendance and price setting. In R. G. Noll (Ed.), Government and the
sports business (pp. 115-157). Washington, DC: Brookings Institution Press. 

Owen, J. G. (2003). The stadium game: Cities versus teams. Journal of Sports Economics,
4(3), 183-202. 

Porter, P. K. (1992). The role of the fan in professional baseball. In P. M. Sommers (Ed.),
Diamonds are forever (pp. 63-76). Washington, DC: Brookings Institution. 



45

Journal of Economics and Economic Education Research, Volume 9, Number 3,  2008

Rascher, D. (1999). A test of the optimal positive production network externality in Major
League Baseball. In J. Fizel, E. Gustafson, & L. Hadley (Eds.), Sports economics:
Current research (pp. 27-45). New York: Praeger.

Salant, D. J. (1992). Price setting in professional team sports. In P. M. Sommers (Ed.),
Diamonds are forever (pp. 77-90). Washington, DC: Brookings Institution. 

Scully, G. W. (1989). The Business of Major League Baseball. Chicago: University of
Chicago Press. 

Zimbalist, A. (2003). May the Best Team Win: Baseball Economics and Public Policy.
Washington, DC: Brookings Institution.



46

Journal of Economics and Economic Education Research, Volume 9, Number 3, 2008



47

Journal of Economics and Economic Education Research, Volume 9, Number 3,  2008

THE USE OF ECONOMIC HISTORY IN
INTRODUCTORY ECONOMICS

TEXTBOOKS

Daniel C. Giedeman, Grand Valley State University
Aaron Lowen, Grand Valley State University

ABSTRACT

Incorporating historical examples into introductory economics courses
benefits students by providing them with interesting real-world applications and an
understanding of the modern economy's development over time.  We therefore
review almost two dozen standard introductory-level economics texts to determine
the number, depth and variety of economic history references they employ.  The
presentations of economic history vary greatly in both depth and coverage across
textbooks.  We categorize historical references in several ways of potential use to
faculty attempting to find substantial historical examples or choose a textbook with
a historical perspective: by time period, subject matter and amount of detail
provided.

INTRODUCTION

As noted by John Ise more than eight decades ago, "… a good knowledge
of economic history is absolutely essential to clear economic thinking." (Ise, 1922,
p. 622)  The passage of time has neither belied nor diminished Ise's argument.  For
students to fully appreciate current and future economic conditions, they need to
understand the economy's development over time.  Further, motivating and helping
students to understand the wide applicability of economics to their everyday lives
can be bolstered by showing how these concepts and theories have applied
throughout history.

Unfortunately, evidence suggests that many incoming college students lack
the substantive knowledge of history that would enable them to have a more
complete understanding of economic issues.  A 2006 National Assessment of
Educational Progress survey found that the overwhelming majority of
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twelfth-graders tested had only basic or below-basic knowledge of US History.
Only 13 percent of twelfth-graders were found to have proficient history knowledge
and a mere 1 percent performed at the advanced level (U.S. Department of
Education, 2007).  One potential remedy to address this dearth of historical
familiarity and understanding would be for students to take at least one course in
economic history.  Another, and perhaps complimentary, option that likely would
affect a larger number of students is to present historical examples in other courses,
especially introductory economics courses.

One way that history can be introduced in economics courses is through
textbook references to historical material and events.  In this paper, we evaluate
almost two dozen prominent introductory economics textbooks to determine their
use of historical references to motivate economic subject matter.  The textbooks
were chosen because the authors offer both macro- and micro-economics
introductory texts, large circulation, and availability of recent versions from
publishing companies.  Twelve macroeconomics texts are included, while only
eleven of the twelve microeconomics texts were available (the twelfth being
available only as a "selected chapters" preview version).  We categorize the
textbooks' historical references in several ways of use to economics instructors: by
historical period, economic subject matter and the amount of historical detail
provided in each example. 

Our paper joins a small literature that examines how introductory-level
economics textbooks treat particular topics or subjects.  Our work is somewhat
similar to a series of articles that evaluate economics textbooks to determine the
extent to which they discuss women's and minorities' issues (Feiner & Morgan,
1987; Feiner, 1993; Robson, 2001).  This research measures topic coverage by the
number of pages which mention the topic of interest, either by checking the index
of each textbook or searching visually for terms and counting pages containing those
terms.  This research is also related to research that assesses textbooks treatment of
entrepreneurship (Kent, 1989; Kent & Rushing, 1999).  This second set of papers
uses a similar technique to ours, in which a word count was used to assess topic
coverage.  We are aware, however, of no other research that has examined the
presentation of history in introductory-level economics textbooks.  

METHODOLOGY

In this paper we examine introductory-level economics textbooks to
determine the extent to which they incorporate meaningful historical references and
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examples. To achieve our objective, we first had to determine what exactly
constituted a meaningful historical reference. Our decision for including or
excluding a reference or example among our list of meaningful historical references
is based on two primary dimensions.  First is the question of when history begins
and ends or, perhaps more correctly, the boundary between the end of history and
the beginning of current events.  We choose to make the distinction between
historical events and current events so that our findings truly reflect the historical
focus of our paper and are not skewed by a textbook's inclusion of references to
current events. The second dimension we must consider is the depth to which each
textbook must present a historical topic before it is worthy of being considered a
historical reference.  Does the mere mention of something that happened in the past
or someone who lived in the past constitute a historical reference?  Since there are
no clear and obvious answers to these questions, we present our findings based upon
several different definitions of a "historical reference."

We initially categorize references into three broad historical eras.  The first
era includes all time periods prior to the end of the American Civil War in 1865.
The second era begins in 1866 and continues through the end of the Second World
War in 1945.  The post-war period through 1985 is the third era.  Although these
time periods are arbitrary, we hope that this classification will be useful for
instructors who desire a broad overview of the time periods from which the
historical references were chosen for each textbook. The choice of 1985 as history's
endpoint was motivated by the point of view of current traditional college students.
We suggest that students may view events that happened prior to their births as
historical and consider events that occurred during their lifetimes as recent or current
events.  Our definition of history therefore uses 1985 as the breakpoint between
historical and current events.

The second question, concerning which references warrant being considered
"history" and which ones do not, is more difficult to address.  For example, a
discussion of Adam Smith's pin-making example, a graph showing government
spending over the course of the twentieth century, a brief note of the Kennedy
tax-cuts, and a trivial mention that Mick Jagger of The Rolling Stones dropped out
of the London School of Economics in 1961 are all possibly "historical". They are,
however, clearly of different value when trying to help students gain a historical
perspective on the economy or economic theory.

In an effort to evaluate the wide variety of potentially useful historical
references, we chose to sort historical references into three categories.  The first
category ("mention") is quite broad and includes even passing accounts of historical
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events, topics or issues.  A mention gives little context or detail on the event, policy
or fact.  While length of the discussion is not the defining characteristic of a
mention, they are typically very short, often less than three sentences.  The second
measure ("moderate") is stricter, requiring that the textbook provides context or
depth.  Unlike references in the mention category (which might merely be capable
of serving as a stepping-off point for professors to discuss the underlying historical
topic in class), moderate references provide enough information so that a student can
garner at least some historical knowledge or perspective solely from reading the
reference in the textbook.  The final measure ("intensive") includes only references
with substantial historical content. Again, while length was not a defining
characteristic, intensive references were frequently more than ten sentences in
length.  (A complete list of all of the intensive historical references from the
macroeconomics and microeconomics textbooks may be found in Appendices I and
II, respectively.)

Despite our best efforts to create a precise rubric, discretion and subjectivity
was required.  For example, the aforementioned brief note on the Kennedy tax-cut
example was classified as a mention, while the single sentence concerning Mick
Jagger's career choice was not included at all.  Graphs and tables presenting
time-series data were typically classified as a mention unless they were sufficiently
annotated or discussed in the text to warrant their inclusion in another category.
Finally, we did not count biographies or references to the development of economic
thought as historical unless there was also some connection to specific historical
events or conditions.  For example, references to Adam Smith's pin-making factory
were not considered to be historical unless they made at least some passing reference
to, say, the Industrial Revolution.  

To more clearly illustrate the distinction between our three classifications
of historical references, consider the three following references to the Great
Depression from McConnell and Brue's macroeconomics textbook (2008).  We
classified the reference: "In the depths of the Great Depression of the 1930s,
one-quarter of U.S. workers were unemployed and one-third of U.S. production
capacity was idle." (p. 14) as a mention.  The more substantial discussion:

The Smoot-Hawley Tariff Act of 1930 is a classic example.  Although the
act was meant to reduce imports and stimulate U.S. production, the high tariffs it
authorized promptly adversely affected nations to retaliate with tariffs equally high.
International trade fell, lowering the output and income of all nations.  Economic
historians generally agree that the Smoot-Hawley Tariff Act was a contributing
cause of the Great Depression. (p. 96)
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was included as a moderate reference.  Finally, we determined that a thirty-three
sentence, full-page discussion of the bank panics of 1930 to 1933 (p. 255) should
be considered an intensive historical reference.

FINDINGS FROM MACROECONOMICS TEXTBOOKS

There is a wide variety in the number and intensity of historical references
among the twelve introductory macroeconomics textbooks surveyed, which are
listed in Table One.  As can be seen from Figure One, no textbook stands out as
clearly superior or inferior to the others across all three levels of historical
references.  The total number of all historical references ranges from fifty-three
(Mankiw, 2007) to one hundred (both Shiller, 2006 and Ekelund, Ressler &
Tollison, 2006) with an overall average of 71.0 references and a standard deviation
of 16.7.  If we limit the definition of historical references to include only moderate
and intensive references, the average number falls to 19.5 with a standard deviation
of 5.0.  Hubbard and O'Brien (2006) has the most moderate and intensive references
with thirty-one, while Mankiw (2007) has the least with thirteen.  If we examine
only the intensive historical references, the average falls to 4.4, Mankiw (2007)
having the most (eight) while Parkin (2008) has the least (none).
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Table 1: Macroeconomics Textbooks Analyzed

Authors Textbook Name Edition Year

Case and Fair Principles of Macroeconomics 8th 2007

Colander Macroeconomics 6th 2006

Ekelund, Ressler, and Tollison Macroeconomics: Private
Markets and Public Choice

7th 2006

Frank and Bernanke Principles of Macroeconomics 3rd 2007

Gwartney, Stroup, Sobel, and
Macpherson

Macroeconomics: Private and
Public Choice

11th 2006

Hubbard and O’Brien Macroeconomics 1st 2006

Mankiw Principles of Macroeconomics 4th 2007

McConnell and Brue Macroeconomics 17th 2008

O’Sullivan, Sheffrin, and Perez Macroeconomics: Principles,
Applications, and Tools

5th 2008

Parkin Macroeconomics 8th 2008

Schiller The Macro Economy Today 10th 2006

Tucker Macroeconomics for Today 5th 2008

To present a richer picture of the scope of the historical references we
analyze the textbooks' moderate and intensive historical references in several ways.
 Figure Two shows the breakdown of moderate and intensive historical references
according to the broad time period in which the reference begins.  Hubbard and
O'Brien (2006), Shiller (2006) and Colander (2006) have the greatest number of
references from World War II or earlier, while Parkin (2008), Ekelund, Ressler and
Tollison (2006) and Gwartney, et al. (2006) all have more than 50 percent of their
references from the post-war period.

We further separate the historical references by major historical events and
eras.  Figure Three shows this breakdown by seven selected historical eras:
Antiquity, the Middle Ages, the Industrial Revolution, the American Revolution
(including Colonial times), the Great Depression, World War II and the Oil Shocks
of the 1970s.  Not all of the historical references fit into these seven categories, but
these were the historical events/eras for which historical references were most often
provided.  As would likely be expected, the Great Depression is the most commonly
referenced historical event in macroeconomics textbooks and is the only historical
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event discussed in detail by all of the macroeconomic textbooks reviewed.  World
War II is the only other historical period that is at least mentioned by all of the
textbooks and is discussed in some detail by nine of the twelve books.  (Exact
numerical data on historical references for these major historical events and era
classifications, including data for all historical references, may be found in
Appendix III.)
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Additionally, we classify examples by broad macroeconomic topic.  Figure
Four shows the breakdown by seven major macroeconomic subjects:  Banking
Issues (including central banking), Economic Growth and Development,
Government Budget Issues, Inflation (including deflation, disinflation and
hyperinflation), Labor Issues (including unemployment), Money (including the gold
standard), and Trade.  These are certainly not the only macroeconomic topics for
which historical references were given, but they were the topics for which historical
references were most commonly provided.  Inflation is the only macroeconomic
subject for which historical details are discussed by all of the textbooks, but all
seven of the subjects are at least mentioned in some historical context by all of the
books.  (Exact numerical data on historical references for these broad
macroeconomic topics, including data for all historical references, are given in
Appendix IV.)
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FINDINGS FROM MICROECONOMICS TEXTBOOKS

There is also a wide variety in the number and intensity of historical
references among the eleven introductory microeconomics textbooks surveyed,
which are listed in Table Two.  Overall, there were fewer historical references in the
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microeconomics texts than the macroeconomics texts.  Figure Five summarizes the
breakdown of references in microeconomics textbooks.  The total number of
historical references ranges from thirty-two (for Frank & Bernanke, 2007) to
seventy-five (for Hubbard & O'Brien, 2006) with an overall average of 51.6
references and a standard deviation of 13.4.  If we limit the definition of historical
references to include only moderate and intensive references, the average number
falls to 16.2 with a standard deviation of 3.7.  Hubbard and O'Brien (2006) has the
most moderate and intensive references with twenty-three, while Frank and
Bernanke (2007) has the least with nine.  If we examine only the intensive historical
references, the average falls to 3.4, Tucker (2008) having the most (seven) while
Frank and Bernanke (2007) has the least (one).

Table 2: Microeconomics Textbooks Analyzed

Authors Textbook Name Edition Year

Bade and Parkin Foundations of
Microeconomics

3rd 2007

Case and Fair Principles of Microeconomics 8th 2007

Ekelund, Ressler, and Tollison Microeconomics: Private
Markets and Public Choice

7th 2006

Frank and Bernanke Principles of Microeconomics 3rd 2007

Gwartney, Stroup, Sobel, and
Macpherson

Microeconomics: Private and
Public Choice

11th 2006

Hubbard and O’Brien Microeconomics 1st 2006

Mankiw Principles of Microeconomics 4th 2007

McConnell and Brue Microeconomics 17th 2008

O’Sullivan and Sheffrin Microeconomics: Principles,
Applications, and Tools

4th 2005

Schiller The Micro Economy Today 9th 2003

Tucker Microeconomics for Today 5th 2008

We again analyze the textbooks' moderate and intensive historical
references more closely.  Figure Six parallels Figure Two, containing the breakdown
of moderate and intensive historical references by the time period in which the
reference begins.  Hubbard and O'Brien (2006) and Ekelund, Ressler and Tollison
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(2006) have the greatest number of references from World War II or earlier, while
Case and Fair (2007), Frank and Bernanke (2007), Gwartney, et al. (2006), Mankiw
(2007), and Schiller (2003) all have about 50 percent or more of their references
from the post-war period.
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We classify historical references in microeconomics textbooks somewhat
differently than in macroeconomics texts.  In particular, we do not classify these
references by narrow historical events/eras because the references in the
microeconomics texts were much less concentrated in specific time periods.
Additionally, the interaction of individual and firm incentives, market and industry
structure, public policy, and market failures are intertwined in many examples in
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such a way as to make separating them difficult.  Thus, we chose six microeconomic
topics: Anti-Trust and (De)Regulation, Labor (including unemployment, pay
differences and unions), Trade (international trade and exchange rates but omitting
the Bretton Woods System), Environmental (including pollution, permit trading, and
property rights over land), Agriculture, and Poverty (including income distribution,
public policy, and wealth).  As with macroeconomic topics, these categories were
chosen based on coverage across the texts, and other categorizations are also
possible.  Anti-trust and (de)regulation was the only microeconomic subject with
moderate or intensive discussions by all of the textbooks; almost all six of the
subjects are mentioned in some historical context by each of the books.  (Exact
numerical data on historical references for these broad microeconomic topics,
including data for all historical references, are given in Appendix V.)
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CONCLUSION

This paper examines the use of historical references by introductory-level
economics textbooks.  In particular, we detail how textbooks employ historical
references across various economic topics and historical periods.  In doing so, we
distinguish between three categories of historical references based upon the depth
to which the textbook presents the references.  Overall, we find substantial
differences across textbooks in the amount of historical information provided.
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While textbooks face opportunity costs when choosing examples and
content for their texts, we believe a concerted effort to provide additional historical
perspective on the economy, policy, and economic theory will make the concepts
covered more convincing to students.  Although contemporary examples excite and
motivate discussion, a number of topics in the list of intensely covered
historically-grounded topics are likely to be intriguing to faculty and students alike.
In particular, the opportunity to show students that economic reasoning works across
time, and that current policy and conditions have understandable, reasonable
foundations is, in our opinion, a ripe area for improvement in introductory
economics textbooks.

The primary benefits of motivating students, helping them understand
discipline-specific content, and helping them see the connections between
disciplines may not necessarily require team teaching, costly curriculum
redevelopment, or a re-thinking of testing strategies.  Instead, we provide a simple
starting point from which faculty can begin to cross boundaries between two
interconnected disciplines.  We hope that our findings will be useful to instructors
desiring to incorporate historical material into their economics courses or economic
material into their history courses.  
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Appendix I:  List of all Intensive Historical References from Macroeconomic Textbooks

Textbook Example Years Sentences Page

Case OPEC Oil Embargo and Price Controls
for Gasoline

1970s 23 80

Case Macroeconomic History since World
War II

1945-Present 20 96

Case World Monetary Systems 1900-Present 114 438

Colander Appendix on the History of Economic
Systems

1000-1980s 201 84

Colander History of US Banking 1790s-1930s 27 317

Colander Appendix on the History of Exchange
Rate Systems

1860s-Present 89 481

Ekelund Did Keynesian Policies during WWII
end the Great Depression?

1940s 19 590

Ekelund Irish Pubs Operating as Banks 1960s-70s 40 646

Ekelund Banking Regulation since the Great
Depression

1930s-Present 51 663

Ekelund Japanese Growth since World War II 1945-Present 24 735

Ekelund Tariffs in the US 1820-Present 27 781

Ekelund Bretton-Woods 1940s-1970s 58 808

Frank Great Depression 1930s 36 97

Frank Germany & Japan after WWII 1940s-1980s 20 189

Frank Banking Panics & Fed Policy during the
Great Depression

1907-1930s 27 283

Frank Inflation during the Vietnam War 1960s 18 438

Frank Volcker Disinflation 1979-1980s 36 455

Frank Blockade during US Civil War 1860s 9 487

Frank Policy mistakes during the Great
Depression

1930s 31 546

Gwartney Perverse Macro Policies in the Great
Depression

1930s 42 340

Gwartney Government Spending 1790s-Present 37 420

Hubbard Henry Ford & the $5 day 1910s 15 243

Hubbard England's Industrial Revolution 1760-1830 25 295
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Hubbard Great Depression (multiplier in reverse) 1930s 18 354

Hubbard German Hyperinflation 1920s 19 430

Hubbard Fiscal Policy in Great Depression (Did
it fail?)

1930s 14 492

Hubbard Volcker Disinflation 1979-1980s 25 531

Hubbard History of Gold Standard & Bretton
Woods

1810s-1970s 90 596

Mankiw Homo Sapiens vs. Homo
Neanderthalensis

40,000-30,000
BC

31 56

Mankiw Henry Ford and the $5 day 1910s 22 218

Mankiw History of Money 600s BC-1500s 38 228

Mankiw German Hyperinflation 1920s 45 256

Mankiw Wizard of Oz / Late 19th-Century
Free-Silver Debate

1880s-1910s 31 265

Mankiw Great Depression & WWII (shifts in
AD)

1930s-1940s 27 348

Mankiw Oil Shocks of the 1970s (shifts in AS) 1970s 19 353

Mankiw Volcker Disinflation 1979-1980s 27 400

McConnell Banking Panics during the Great
Depression

1930s 33 255

McConnell Collapse of the Bretton Woods System 1940s-1970s 22 372

Osullivan Markets in POW camps in World War II 1940s 14 57

Osullivan Fiscal Policy in US History 1930s 54 223

Osullivan Bretton Woods 1940s-1970s 28 410

Shiller Unemployment since the Great
Depression

1930s-Present 20 125

Shiller Great Depression 1920s-1930s 42 154

Shiller Business Cycle since the Great
Depression

1920s-Present 25 159

Shiller History of the US Debt since the
American Revolution

1770s-Present 49 253

Shiller Bank Panics and Failures since the
Great Depression

1930s-1990s 30 281
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Shiller Inflation during the American
Revolution

1770s 16 316

Shiller Protectionist Policies in the Great
Depression

1930s 14 429

Tucker Currency during the American
Revolution

1770s-1790s 32 346

Tucker Monetary Policy during the Great
Depression

1930s 24 397

Tucker Wage and Price Guidelines since World
War II

1940s-1970s 24 424

Tucker Inflation and Ford's WIN Button 1970s 23 425

Tucker Gold Standard & Bretton Woods 1870s-1970s 34 458

Appendix II:  List of all Intensive Historical References from Microeconomic Textbooks

Textbook Example Years Sentences Page

Bade San Francisco earthquakes, rent
controls, and housing shortages

1906-1946 27 171

Case OPEC oil embargo and price controls 1973-present 29 80

Case Development of calculator technology 1950s-present 47 253

Case Antitrust regulations, examples, and
enforcement

1860s-present 111 289

Ekelund DeBeers cartel 1800s-present 25 279

Ekelund Anti-trust policies and examples 1880s-present 73 380

Ekelund Franchising funerals in England and
France

1800s 22 394

Ekelund Tariffs in the US 1800s 27 781

Ekelund Bretton-Woods system and its end 1940s-1970s 58 808

Frank Effects of blockade on South's cotton
trade during Civil War

1860s 9 245

Gwartney Government spending and taxation 1790s-present 29 357

Gwartney Women in the labor force 1960-present 36 416

Gwartney CAFE fuel economy standards 1970s-present 32 440
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Gwartney Rainey Preserve: National Audubon
Society and natural gas deposits

1940s-present 22 444

Hubbard Effects of Clean Air Act on infant
mortality

1970s-present 12 136

Hubbard US Antitrust Laws and surrounding
environment

1890s-present 21 459

Mankiw Trade: neanderthal vs. homo sapiens 40,000-30,000
BC

32 56

Mankiw Laffer curve and the impact on
presidential platforms

1970s-present 21 170

Mankiw Enclosure movement in England in the
17th century (public goods)

1600s 26 231

Mankiw Luddite revolt 1810s 14 400

McConnell Antitrust Law and cases 1860s-present 67 349

McConnell Women in orchestras and discrimination 1960s-1990s 25 436

McConnell Bretton Woods System (and collapse)
and the IMF

1940s-1970s 50 474

O'Sullivan WW2 POW camp: cigarette economies 1940s 14 54

O'Sullivan US Government antitrust laws 1890-1980 13 368

O'Sullivan History of unions, laws and working
conditions

1860s-1940s 15 406

Schiller Calculators, computers, and VCRs 1970s-1990s 47 176

Schiller Civil Aeronautics Board: Airline
Deregulation

1930s-1970s 68 264

Schiller The Second Farm Depression 1980s 55 304

Schiller Smoot-Hawley Tariff Act 1930s 12 423

Tucker Monopoly example: Standard Oil 1850s-1910s 19 230

Tucker Growth of trusts and antitrust laws and
examples

1870s-1950s 58 320

Tucker Regulation example: Utah Pie 1950s-1960s 19 324

Tucker Regulation examples: Standard Oil,
Alcoa, IBM, AT&T, MIT, Microsoft

1910s-present 53 325

Tucker Phases of US regulation and agencies 1880s-present 29 330
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Tucker Airline regulation, Civil Aeronautics
Board

1930s-present 25 336

Tucker Exchange rates: gold standard, fixed,
floating

1870s-1970s 17 394

Appendix III:  Historical References in Macroeconomic Textbooks by Topic

Textbook Banking Growth Gov. Budget Inflation Labor Money Trade

Case 1/2 3/7 0/1 1/10 1/11 0/2 3/7

Colander 4/6 1/3 0/3 2/5 2/7 0/1 4/11

Ekelund 3/7 3/12 1/8 1/11 0/12 0/5 3/6

Frank 1/2 2/5 1/1 3/12 1/9 2/3 3/8

Gwartney 2/2 1/5 2/8 1/5 0/7 0/3 0/8

Hubbard 0/3 4/10 1/6 4/5 2/4 5/7 1/9

Mankiw 1/3 1/3 0/2 4/18 2/8 1/2 1/3

McConnell 3/8 1/2 1/2 2/11 2/7 1/1 5/9

O'Sullivan 1/3 3/8 0/3 2/7 2/6 1/3 0/7

Parkin 1/3 3/8 1/2 5/10 2/7 0/1 4/9

Shiller 3/6 0/2 3/5 3/13 1/12 1/7 1/5

Tucker 3/8 0/2 1/7 4/5 2/7 3/5 2/4

Note:  The number listed to the left of the slash is the sum of moderate and intensive references,
while the number following the slash is all references (which includes mentions).

Appendix IV:  Historical References in Macroeconomic Textbooks by Event or Era

Textbook Antiquity Middle
Ages

Industrial
Revolution

American
Revolution

Great
Depression

World
War II

1970s Oil
Shocks

Case 1/1 1/1 2/2 0/0 4/9 0/1 2/3

Colander 1/2 2/4 2/3 1/1 1/5 2/2 0/0

Ekelund 0/3 2/3 0/0 0/0 4/10 3/9 2/4

Frank 0/0 0/0 0/1 1/1 3/7 3/4 1/4

Gwartney 0/0 1/1 0/0 0/1 2/8 0/3 0/0
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Textbook Antiquity Middle
Ages

Industrial
Revolution

American
Revolution

Great
Depression

World
War II

1970s Oil
Shocks
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Hubbard 2/3 0/0 1/1 0/2 5/8 2/2 0/1

Mankiw 2/2 0/0 0/0 0/2 2/4 1/2 1/2

McConnell 0/0 2/2 0/0 0/0 5/13 1/2 2/4

O'Sullivan 0/0 0/0 0/0 0/0 2/13 1/5 0/3

Parkin 0/2 1/3 0/3 0/0 3/7 0/2 1/1

Shiller 0/1 0/0 0/0 2/5 6/21 1/5 0/1

Tucker 0/0 1/1 0/0 1/1 4/10 1/4 0/2

Note:  The number listed to the left of the slash is the sum of moderate and intensive references,
while the number following the slash is all references (which includes mentions).

Appendix V:  Historical References in Microeconomic Textbooks by Topic

Textbook Trade Anti-Trust Labor Poverty Agriculture Environmen
tal

Bade 1/7 4/7 0/4 0/3 1/2 1/2

Case 3/7 4/12 1/4 1/4 1/5 0/1

Ekelund 1/6 7/9 2/5 1/6 0/2 2/2

Frank 2/2 2/3 0/5 1/5 0/0 0/0

Gwartney 0/9 1/7 2/6 2/6 0/1 7/9

Hubbard 1/11 6/10 2/8 0/6 1/6 1/3

Mankiw 1/4 4/9 4/7 0/3 2/3 0/2

McConnell 5/10 4/8 3/12 1/4 0/6 0/1

O'Sullivan 3/5 4/7 2/5 1/2 1/2 0/2

Shiller 2/12 3/8 2/7 0/3 2/4 0/1

Tucker 1/6 7/8 2/3 0/5 1/4 0/0

Note:  The number listed to the left of the slash is the sum of moderate and intensive references,
while the number following the slash is all references (which includes mentions).
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APPLYING MODERN PORTFOLIO
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DATA

Lihui Bai, Valparaiso University
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Paul Newsom, Valparaiso University

ABSTRACT

Time constraints, as well as ignorance of other business disciplines, often
preclude instructors from properly incorporating illustrations from outside their
area of expertise into their courses.  This can result in students having difficulty in
applying skills learned in one course to other courses.    We address this student
learning issue by showing how the skills and concepts students are learning in an
introductory Excel spreadsheet class can be applied to modern portfolio theory
using real data from Yahoo! Finance without mathematical and statistical
complexity.  By using a finance illustration in an information systems course,
students are better able to understand the value of the skills they are acquiring now
and how these skills will help them solve real-life problems.  Moreover, business
students who subsequently take an introductory finance course will be familiar with
one of finance’s most important theories. 

INTRODUCTION

Many business students have difficulty applying knowledge learned in one
class to other classes, especially if the class is not in their major discipline.
Professors often hear statements like the following from students, “I’m a finance
major, why do I need to know something about information systems.”  For these
students there is a no connection of how the concepts and skills learned in one class
can help them solve problems in another class.  In 2002 the Association of American
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Colleges and Universities published a report entitled Greater Expectations: A New
Vision for Learning as a Nation Goes to College that addresses this student learning
issue.  The report states the following “Once enrolled in College, students face …
barriers to excellence.  The fragmentation of the curriculum into a collection of
independently “owned” courses is itself an impediment to student accomplishment,
because the different courses students take, even on the same campus, are not
expected to engage or build on one another.  Few maps exist to help students plan
or integrate their learning as they move in and out of separately organized courses,
programs, and campuses.  In the absence of shared learning goals and clear
expectations, a college degree more frequently certifies completion of disconnected
fragments than of a coherent plan for student accomplishment.”  The Association of
Advance Collegiate Schools of Business (AACSB International) expresses similar
student learning concerns in their 2003 Eligibility Procedures and Standards for
Business Accreditation.  This AACSB publication promotes cross-functional
integration within business programs.  We address this student learning issue by
showing how students can apply finance’s modern portfolio theory using real data
in an introductory Excel spreadsheet class.

1990 Nobel Prize winner in economics, Harry Markowitz (1952), is credited
with developing modern portfolio theory.  His work shows that the adage “don’t put
all your eggs in one basket” is sound advice.  In financial terms he shows that it is
possible for investors to combine financial assets (stocks) in such a way that it
increases their return while also decreasing their risk.  We show that students taking
an introductory Excel spreadsheet course can apply his work using real stock price
data from Yahoo! Finance.  By using a finance application in an information
systems class, students will understand how the skills and concepts they are learning
in an introductory Excel spreadsheet course can help them in other classes that are
often taken years later.  It also introduces students to the risk-return trade-off in
finance that investment and introductory finance courses cover in detail.  Moreover,
a number of finance textbooks use Excel to solve and illustrate problems.iii  Finally,
there are a growing number of financial modeling courses at universities and a
growing number of financial modeling textbooks that use Excel extensively.iv

The purpose of this paper is to show students how simple Excel functions
that they commonly learn in an introductory Excel spreadsheet class can help them
understand modern portfolio theory without mathematical and statistical complexity.
Having students simulate the process of portfolio construction will help them better
understand the decision process that money managers use in making their asset
allocation decisions. Using Excel’s solver and scenario manager students can
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perform a risk-return analysis in little time by developing an efficient frontier and
capital market line.v  First, Excel’s solver is a tool that optimizes a dependent
(output) variable by changing the values of independent (input) variable(s) subject
to some constraint(s).  Solver finds a new solution to the problem each time you
change the value of the dependent variable or the value of a constraint.  The solver
function is a part of Excel’s Solver add-in.  If this function is not currently available
under the Tools menu, it can be installed by loading the Solver add-in.  To do this,
go to the Tools menu and click Add-ins.  In the Add-Ins available list, select the
Solver box, and then click OK.  Second, scenario manager is a tool that can store
the solutions from solver.  Moreover, it provides a convenient way to summarize the
solutions that solver produces.  In addition to solver and scenario manager, students
will learn about naming cells and/or ranges, absolute and relative cell referencing,
basic functions such as average, stdev, and correl, paste special with several
optional features, and array formulas.

DOWNLOADING DATA AND COMPUTING RETURNS

To get free historical stock price data go to the following link
http://finance.yahoo.com/.  This is the home page for Yahoo! Finance.  In the
Market Summary section there are a number of stock indices listed, click on Dow
and a new page will appear.  On this page go to the More On section, click on
components.  This page contains an alphabetical listing of the 30 firms that comprise
the Dow Jones Industrial Index with their ticker symbols.vi As of December 14,
2005, Alcoa Inc. (symbol: AA) was the first firm.  The screen should look similar
to figure 1.

Figure 1
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Clicking on the first ticker symbol, AA, opens AA’s Yahoo! Finance home
page.  In the section More on AA click on historical prices.  In the set date range
select monthly.  In the start date select December 31, 2001.  In the end date select
December 31, 2004.  Now click on Get Prices.  Scroll down the page and select
Download to Spreadsheet.  Click on Save and in this case the ticker symbol is AA
so name the file AA.  By default the file will be saved as comma separated with the
file extension .csv.  Now select Open and an Excel worksheet that looks like figure
2 will appear.

Figure 2

Now select columns B:F by hovering the mouse over column B and holding
down the left mouse button while moving the mouse over to column F.  Release the
left mouse button and delete these columns by right clicking the mouse and selecting
delete.  Next, in cell B1 enter AA Prices and in cell C1 enter AA returns.

To compute monthly stock price changes in decimals for AA select cell C2
and enter the formula =B2/B3-1.  Copy this formula down to cell C37 by selecting
cell C2 and hovering the pointer over the lower right corner of cell C2 until it turns
into a black plus sign.  Hold down the left mouse button and drag to cell C37, then
release.  To save your file go to File>Save As.  In the file name enter AA and in the
Save as Type select Microsoft Excel Workbook by scrolling up.  The saved file will
look like figure 3.
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Figure 3

Repeat this process for the remaining 29 stocks left in the Dow index.
Remember to use the appropriate ticker symbols to name the files and for naming
price and return columns within each file.  To help organize the files it is probably
best to create two new folders.  One folder will contain .csv files with price data
downloaded from Yahoo! Finance and the other folder will contain .xls files that
have just dates, prices, and computed monthly stock returns.

Finally, to get a risk-free rate of return go to http://finance.yahoo.com/, enter
^IRX in the Enter Symbol(s) area and click on GO.  ̂ IRX is the ticker symbol for the
13-week U.S. treasury bill.  Use the same start dates and end dates as before and
name the .csv file using the ticker symbol when downloading the information.   Now
select Open and an Excel worksheet that looks like figure 4 will appear.

Delete columns B:F like before.  Next, in cell B1 enter ̂ IRX Annual Returns
and in cell C1 enter ^IRX Monthly Returns.  To compute monthly returns for ^IRX
select cell C2 and enter the formula =B2/(12*100).vii  Copy this formula down to cell
C37.  To save the file go to File>Save As.  In the file name enter ^IRX and in the
Save as Type select Microsoft Excel Workbook by scrolling up.  The saved file will
look like figure 5.
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Figure 4

 Figure 5

CREATING THE MASTER RETURN FILE

Currently there are 31 Excel files and we need to create one file that
contains the returns for all 30 firms in the Dow Jones and the 13-week U.S. treasury
security.  Start by opening Excel and select File>Save As. In the file name enter
master and select save.  Second, open the AA file with the .xls extension and select
column A.  Copy column A in the AA file to the master file by selecting Edit>Copy
from the menu bar and then select column A in the master Excel workbook and
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paste the column by selecting Edit>Paste.  Third, copy column C in the AA file to
the master file by selecting Edit>Copy from the menu bar and then select column
B in the master Excel workbook and paste the column by selecting Edit>Paste
Special>Values.  Pasting values changes the formulas in this cell range to numbers.
Fourth, close the AA file by going to the AA file and selecting File>Close.  

For the remaining .xls files containing returns do not repeat the copy process
for the dates.  However, repeat the copy process for the returns of the other 29 firms
and the 13-week U.S. treasury security.  For example, open the AIG file and select
column C.  This is the column that contains the returns for AIG.  Copy column C in
the AIG file to the master file by selecting Edit>Copy from the menu bar and then
select column C in the master Excel workbook and paste the column by selecting
Edit>Paste Special>Values.  Close the AIG file by going to the AIG file and
selecting File>Close.  Copy the returns of the remaining 28 firms and the 13-week
U.S. treasury security.  After copying the returns, the master Excel file will look like
figure 6.

Figure 6

RETURN STATISTICS

To create the efficient frontier and capital market line we need to compute
some summary statistics.  In cell A38 type the label Total Return, in cell A39 type
the label Annualized Return, in cell A40 type the label Std Dev of Monthly Returns,
and in cell A41 type the label Annualized Std Dev.viii  To compute the total return,
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select cell B38 and enter =PRODUCT(1+B2:B37)-1 while holding down the ctrl and
shift buttons on the keyboard.  Holding these two buttons down while hitting enter
will put brackets {} around the formula and this creates an array formula.  Copy this
formula across row 38 to cell AF38.  To compute the annualized return, select cell
B39 and enter =(1+B69)^(1/3)-1.  Copy this formula across row 39 to cell AF39.
To compute the std dev of monthly returns, select cell B40 and type =stdev(b2:b37).
Copy this formula across row 40 to cell AF40.  Finally, to compute the annualized
std. dev, select cell B41 and type =B40*SQRT(12).  Copy this formula across row
41 to cell AF41.

To help organize the workbook, rename Sheet1 by moving the pointer over
Sheet1 and right clicking the mouse.  A pop-up menu will appear and select rename.
Rename this worksheet by entering Returns.   Likewise, rename sheet2 to Portfolio.

EFFICIENT FRONTIER WORKSHEET-FORMATTING

To create the efficient frontier we need to enter some cell labels on the
Portfolio worksheet and compute some additional statistics.  Much of the work in
this section involves moving between the Returns worksheet and Portfolio
worksheet.  We begin by entering cell labels on the Portfolio worksheet and copying
statistics from the Returns worksheet to the Portfolio worksheet.

Go to the Portfolio worksheet and in cell A1 enter Asset, in cell B1 enter
Annualized Std Dev, and in cell C1 enter Annualized Return.  Now select the Returns
worksheet and highlight cells B1:AF1 and select Edit>Copy.  Go back to the
Portfolio worksheet, highlight cell A2 and paste this information by selecting
Edit>Paste Special.  Be sure to transpose the cell range and copy values.
Transposing a row of cells changes it into a column of cells.  Repeat this process for
the annualized standard deviation and annualized return.  For example, go to the
Returns worksheet, highlight the cell range B41:AF41, and select Edit>Copy.
Return to the Portfolio worksheet, select cell B2 and paste this information by
selecting Edit>Paste Special.  Be sure to transpose the cell range and copy values.
After copying the annualized return information, the Portfolio worksheet will look
like figure 7.

Next, we need to create three matrices on the Portfolio worksheet.ix  The
first matrix is for stock return correlations.  In cell A34 enter Correlation of Monthly
Stock Returns.  We first create labels for the 30 stocks in range A36:A65 by entering
a formula =A2 in cell A36 and then copy this formula to cell A65.  Be sure that you
don’t copy the 13-week treasury bill returns.  It is not needed for this matrix.  Next,
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we paste the labels we just created in the range A36:A65, a range aligned in a
column, to the range C35:AE35, a range aligned in a row.  We do this by selecting
the range A36:A65 and then go to Edit>Copy.  Next, move the cursor to cell B35,
and then go to Edit>Paste Special checking two options: Values and Transpose.
Figure 8 shows the results.

Figure 7

Figure 8

The second matrix is for stock return variances and covariances.  In cell A67
enter Variance-Covariance of Monthly Stock Returns.  Similar to the correlation
matrix, two identical sets of labels for the 30 stocks need to be created in range
A69:A98 and range B68:AE68, respectively.  Note, the 13-week treasury bill data
is not needed in this matrix either.  Figure 9 shows the results.
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Figure 9

The third matrix is needed to compute statistics for the portfolio of 30
stocks.  First create labels for the 30 stocks in ranges A69:A133 and C102:AF102,
respectively, using similar techniques.  Next, we create weights for each of the 30
stocks in a portfolio.  In cell B103 enter the label Weight.  In cell B104 enter =1/30
and copy this formula to cell B133.  The original portfolio is going to be equally
weighted.  Since there are 30 stocks in the portfolio, we will invest 1/30 in each
stock.  To change the formulas in this cell range to values highlight the cell range
B104:B133, select Edit>Copy>Edit>Paste Special, and select values.  We need to
change the formulas to values so that solver can find solutions in the following
section.  Next, we need to transpose the weights we just created in range B04:B133
to range C103:AF103. However, this time we use another technique instead of the
Edit>Paste Special used for the other two matrices.  Again, the reason for this is that
it is necessary step for solver to find solutions in the next section.  The new
technique uses the offset function in Excel. First, create auxiliary labels 1, 2, 3,
through 30, in range C100:AF100 as follows: in cell C100 enter 1, in cell D100
enter 2, then select both cells C100 and D100 and hover the pointer over the lower
right corner of cell D100 until it turns into a black plus sign, hold down the left
mouse button and drag to cell AF100.   Next, enter the formula
=offset($B$103,C100,0) in cell C103, and then copy the formula to AF103.   You
can check your formulas in the range C103:AF103 by changing a weight in the cell
range B104:B133.  For example, select cell B119.  This is the weight for JNJ and it
is currently set equal to 0.033333. Change this value by entering 0.10.  Now go to
cell R103 and the value should be 0.10. 

To finish labeling the Portfolio worksheet select cell A134 and enter Sum
of Weights; A135, enter Portfolio Variance; A136, enter Portfolio Standard
Deviation; A137, enter Portfolio Return; and A138, enter Capital Market Line.  Now
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that the cell labeling is finished we can proceed to computing statistics for the three
matrices.  Figure 10 shows the results.

Figure 10

EFFICIENT FRONTIER WORKSHEET-FORMULAS

On the Portfolio worksheet select cell B36 in the correlation matrix.  To
enter correlations select Insert>Function.  In the search for a function area type
correl, select Go, then OK.  This brings-up Excel’s correlation function, which is
named correl.  Select Array1 by moving the pointer to the spreadsheet symbol to the
right of the text box and right clicking the mouse.  Now select the Returns
worksheet, highlight the cell range B2:B37 and hit enter.  The following should
appear in the Array1 text box Returns!B2:B37.  Next, select Array2.  Now select the
Returns worksheet, highlight the cell range B2:B37, hit enter and click OK.  This
computes the correlation between AA and AA.  To increase efficiency change the
formula in cell B36 by entering dollar signs ($).  To do this, select cell B36 on the
Portfolio worksheet and go to the formula.  Currently the formula should read
=CORREL(Returns!B2:B37,Returns!B2:B37).  Change the formula so that it reads
=CORREL(Returns!$B2:$B37,Returns!B2:B37) and hit enter.  Copy the formula in
cell B36 to the cell range C36:AE36.  Repeat this process for the remaining cells.
For example, select cell B37 and go to Insert>Function.  The Correl function should
be highlighted under the section select a function so click OK.  If not, repeat the
process above.  Select Array1.  Now select the Returns worksheet, highlight the cell
range C2:C37 and hit enter.  The following should appear in the Array1 text box
Returns!C2:C37.  Next, select Array2.  Now select the Returns worksheet, highlight
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the cell range B2:B37, hit enter, and click OK.  Currently the formula should read
=CORREL(Returns!C2:C37,Returns!B2:B37).  Change it so that it reads
=CORREL(Returns!$C2:$C37,Returns!B2:B37).  Copy the formula in cell B37 to
the cell range C37:AE37.  Repeat this process for the remaining cells.x  The cell
formulas for the correlation matrix are in appendix A.

To enter the variances and covariances go to the Portfolio worksheet, select
cell B69, enter the formula =B36*B2*$B$2, and copy it down column B to cell B98.
Next, select cell C69 on the Portfolio worksheet, enter the formula =C36*B2*$B$3
and copy it down column C to cell C98.  Continue entering formulas in this manner
for columns D to AE.  In column AE, select cell AE69, enter the formula
=AE36*B2*$B$31, and copy it down column AE to cell AE98.  The cell formulas
for the variance-covariance matrix are in appendix B.

The last matrix is the border multiplied variance-covariance matrix.  We
need to compute values in this matrix so that we can compute the variance and
standard deviation for the portfolio.  Go to the Portfolio worksheet, select cell C104
and enter =$B104*C$103*B69.  Copy the formula in C104 to the range
C104:AF133. 

To finish entering formulas into the Portfolio worksheet select cell B134 and
enter =SUM(B104:B133).  Copy this formula across row 134 to cell AF134.  The
sum of weights should equal 1 in cell B134.  Continue computing portfolio statistics
by selecting cell B135 and entering =SUM(C134:AF134).  Third, select cell B136
and enter =B135^(1/2).  Fourth, select cell B137 and enter
=sum(B104:B133*C2:C31) while holding down the ctrl and shift buttons.  Again,
holding these two buttons down while entering a formula will put brackets {} around
the formula and this creates an array formula.  Fifth, select cell B138 and enter
=(B137-C32)/B136.  The cell formulas for the border multiplied variance-
covariance matrix are in appendix C.

Finally, we will change the names of some cells.  Changing the names of
these cells will make it easier to interpret results later on.  Go to the Portfolio
worksheet and select cell B134.  Just to the left of the formula bar where the formula
=SUM(B104:B133) appears is the cell reference B134.  Select this area, type
weights, and hit enter.  The name of this cell is now weights instead of B134.
Repeat this process for the following cells: name B135 variance, B136 std_dev,
B137 return, B138 CML, B32 rf_std, and C32 RF_return.
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ORIGINAL PORTFOLIO

The original portfolio is equally weighted and we will save this information
for this portfolio by saving it as a scenario.  To do this go to Tools>Scenarios and
select Add.  Name the scenario original portfolio and in the changing cells text box
enter B104:B133.  Select OK and a pop-up menu named scenario values will appear.
Make sure that all values in these cells are set equal to 0.033333 and select OK.  The
scenario manager will now have a new scenario named original portfolio.  Click
close. 

EFFICIENT FRONTIER 

To use solver go to Tools>Solver. In the select target cell input $B$135 and
in the Equal to: click Min.  Cell B135 is the output (dependent) variable.  In the By
Changing Cells enter $B$104:$B$133.  The cell range B104:B133 contain the input
(independent) variables that solver will change to minimize the variance of the
portfolio.  Next, we need to add constraints.

To add the constraints, select Add.  For the first constraint do the following.
In the cell reference input $B$134, select =, and in the Constraint input 1.  Click
Add.  For the second constraint, enter $B$137 in the cell reference, select =, and in
the Constraint input -0.10.  Click OK.  The solver parameters will look like figure
11.

Figure 11

To run solver click Solve.  If solver successfully finds a solution it will
return a screen similar to figure 12.
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Figure 12

To keep the solution, select Save Scenario and name the scenario r=-10%.
The save scenario screen will look like figure 13.  

Figure 13

Click OK.  We have just saved our first scenario!
To create more scenarios go to Tools>Solver and in the Subject to the

constraints section select return=-0.10 and click Change.  In the Constraint section
enter a new return value equal to -0.075 and click OK.  This will take you back to
the Solver Parameters screen.  Click Solve.  Solver will find a solution and just like
before select Save Scenario.  Name the scenario r=-7.5% and click OK.  Repeat this
process using the following return values: -0.05, -0.025, 0.00, 0.025, 0.05, 0.075,
0.10, 015, 0.20, 0.25,  0.30, 0.325, 0.35, 0.375, 0.40, 0.50, 0.60, 0.70, 0.80, 0.90 and
1.00.  We will graph these scenarios later.

CAPITAL MARKET LINE

To create the efficient frontier we specified a return and had solver
minimize the portfolio variance by changing the weight invested in each stock.  To
find the best capital market line we will have solver maximize the trade-off between
risk and return.  To do this we need to change some inputs in the solver parameters.
Go to the Portfolio worksheet and select Tools>Solver.  In the Set Target Cell
section select cell B138, and in the equal to section select Max.  Do not change the
By Changing Cells section.  The following should be entered in this section



81

Journal of Economics and Economic Education Research, Volume 9, Number 3,  2008

$B$104:$B$133.  Finally, in the subject to the Constraints section delete the
return= constraint.  The Solver Parameters screen will now look like figure 14.

Figure 14

Click Solve and select save scenario. Name the scenario MAX CML.

MINIMUM VARIANCE PORTFOLIO

To compute the minimum variance portfolio select the Portfolio worksheet
and go to Tools>Solver.  In the Set Target Cell section select cell B135 and in the
equal to section select min. The Solver Parameters screen will now look like figure
15.

Figure 15

Click Solve and select Save Scenario.  Name the scenario minimum
variance.
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SCENARIO MANAGER

Scenario manager stores all saved scenarios.  To access these scenarios go
to Tools>Scenarios and a screen that looks like figure 16 will appear.

Figure 16

Scrolling down the Scenarios section shows additional scenarios including
the MAX CML and minimum variance scenarios.  To graph these scenarios select
Summary and in the Results cells input the cell range B136:B138 and the cell range
B32:C32.  The Scenario Summary screen will look like figure 17.

Figure 17

Click OK and a new worksheet named Scenario Summary that looks like
figure 18 will appear.  This worksheet contains the information to graph the efficient
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frontier, capital market line, original portfolio, and minimum variance portfolio.
Positive weights are long positions and negative weights are short positions.xi

Figure 18

GRAPHING

To graph the efficient frontier go to Insert>Chart.  In the Chart type section
select XY (scatter).  In the Chart sub-type section select Scatter with data points
connected by smooth lines.  Click Next and select the Series tab.  In the series
section click Remove until this section is blank.  Now click Add.  Select X Values,
highlight the cell range F37:AB37 on the scenario summary worksheet and hit enter.
Next, select Y Values, highlight the cell range F38:AB38 on the scenario summary
worksheet and hit enter.  Name the series by entering Efficient Frontier in the Name
section.

To graph the capital market line click Add.  Select X Values and while
holding down the CTRL button, select cell AC40, then cell AC37 on the Scenario
summary worksheet and hit enter.  Select Y Values and while holding down the
CTRL button select cell AC41, then cell AC38 on the Scenario summary worksheet
and hit enter.  Name the series Capital Market Line.
To graph the minimum variance portfolio click Add.  Select X Values, then select
cell AD37 on the Scenario summary worksheet and hit enter.  Next, select Y Values,
then select cell AD38 on the Scenario summary worksheet and hit enter.  Name the
series Minimum Variance Portfolio.  

To graph the original portfolio click Add.  Select X Values by selecting cell
E37 on the Scenario summary worksheet and hit enter.  Next, select Y Values by
selecting cell E38 on the Scenario summary worksheet and hit enter.  Name the
series original portfolio.  Click Next.
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Finish the graph by selecting the Titles tab.  In the Chart Title section enter Efficient
Frontier, CML, and Min Var Portfolio, in the Value (x) axis section enter Standard
Deviation, and in the Value (Y) axis section enter Return.  Click Next and select as
new sheet.  Name the new sheet Graph and select Finish.

To extend the capital market line left click on the line to highlight it.  Now
right click and a screen like figure 19 will appear. 

Figure 19

Select Add Trendline.  Select the Type tab and in the Trend/Regression Type
highlight Linear.  Now select the Options tab.  In the Trendline name section select
Automatic, and enter 0.10 for forward under the Forecast section.  Click OK.  The
graph should look similar to figure 20.

Figure 20

Efficient Frontier, CML, and Min Var Portfolio
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INTERPRETING THE GRAPH

The minimum variance portfolio is the mixture of risky stocks that reduces
risk (standard deviation) to its lowest possible level.  Every portfolio at and above
the minimum variance portfolio is said to be on the efficient frontier and every
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portfolio below the minimum variance portfolio is said to be on the inefficient
frontier.  Notice that any investor choosing a portfolio on the inefficient frontier can
increase return without increasing risk (standard deviation) by moving to a portfolio
that lies directly above on the efficient frontier. 

The original portfolio, even though it is well diversified, is not efficiently
diversified.  By changing the weights invested in each stock we can significantly
increase the return of the portfolio while decreasing risk.  

The capital market line is the line that begins at the risk-free rate of return
and “just touches” the efficient frontier.  The point where the capital market line
touches the efficient frontier is a special portfolio called the market portfolio.
Investors at this point, have 100 percent of their funds invested in the Dow Jones
index and 0 percent invested in the risk-free treasury bill.  Other investors might be
more risk averse and want to invest a portion of their funds in the risk-free treasury
bill.  They can accomplish this by lending (investing) some funds at the risk-free
rate.  Some investors might be so risk averse that they invest 100 percent in the risk-
free treasury bill and 0 percent in the market portfolio.  In this case, these investors
will be at the point on the capital market line that intersects the y-axis.

Finally, notice that all investors will invest in some combination of the
market portfolio and risk-free treasury bill.  To illustrate this, suppose that some
investor chose to invest in the minimum variance portfolio.  Interestingly, this
investor can increase return without increasing risk by alternatively investing X
percent in the market portfolio and (1-X) percent in the risk-free treasury bill, and
reach a point on the capital market line that is directly above the minimum variance
portfolio.

WHAT IF

Suppose the risk-free rate of return changes.  For example, suppose the
United States Federal Reserve performs some open market operations over a period
of time that causes the current risk-free rate of 0.0133…in cell C32 of the Portfolio
worksheet to change to 0.075.  Input the new risk-free rate in cell C32 and use solver
to maximize the capital market line in cell B138 just like before.  Excel will find a
new solution.  Save the scenario as before and give it the name NEW MAX CML to
differentiate it from the original MAX CML scenario.  Finally, perform a scenario
summary like before.  All of the original scenarios will appear plus the new one.
Graph the NEW MAX CML with all of the other original information to see how the
line changes. 
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CONCLUSION

We show that the skills students learn while in an introductory Excel
spreadsheet class can be applied to modern portfolio theory without mathematical
and statistical complexity.  By showing students how the skills and concepts they
are learning in a spreadsheet class can help them to understand concepts and
theories in other business disciplines (e.g. finance) we address a common student
learning issue.  Namely, we help students overcome a disconnect of how the
concepts and skills learned in one course can help them solve problems in another
course.  Furthermore, it introduces business students to the fundamental risk-return
trade-off in finance that investment and introductory finance courses cover in more
detail.  Introducing students to portfolio theory prior to taking the finance course
that most colleges of business require will help them better understand this
important concept.  Finally, this example helps instructors of introductory Excel
spreadsheet classes illustrate the value of the skills they are teaching to non-
information systems students.

TEACHING NOTES FOR THE CASE OF SIMULATING THE CHOICES
OF MONEY MANAGERS BY APPLYING MODERN PORTFOLIO

THEORY USING REAL STOCK PRICE DATA

CASE DESCRIPTION

As written, the audience for this case is business students who are taking an
introductory Excel spreadsheet class.  Nonetheless, this case can be adapted to other
courses in finance and investments at the undergraduate level.  Moreover, we use
this case at the M.B.A. level for students who are taking a pre-requisite spreadsheet
or finance course.  Most of these students have non-business undergraduate degrees
and have little or no spreadsheet skills or knowledge of finance theory.

This case is a ‘how to’ case and it simulates the process that a money
manager uses in selecting assets during portfolio construction.  In the introductory
Excel class we cover the case over multiple weeks as topics are covered in the
course.  This case becomes a major student project at this level and it illustrates how
the skills students learn in the course can be applied to another business discipline.
In undergraduate investment and finance courses we use this case as a part of a
semester project where students pick their own portfolio of stocks and get to decide
their weights individually.  We assign this part of the project as portfolio theory is
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discussed in class.  At the pre-requisite M.B.A. level we give students the case as
written and have them complete the case prior to discussing portfolio theory.  Since
these students have little or no spreadsheet skills or knowledge of finance theory,
it is helpful for these students to learn by doing.

This case has two specific learning objectives: (1) show students how the
skills they learn in one course can be applied to another course, and (2) increase
student spreadsheet skills and understanding of finance theory by simulating the
process that money managers use in putting together a portfolio of assets.  

CASE SYNOPSIS

This case places students in the role of a money manager who has the task
of putting together a portfolio of stocks that will minimize risk and maximize return.
Brinson, Singer, and Beebower (1991) show that asset allocation accounts for over
90 percent of the variation in portfolio returns.  Thus, portfolio construction and
management is one of the most important financial concepts.  This case shows
students how to construct a portfolio of stocks using real data from Yahoo! Finance.

ENDNOTES

iii Examples include Investments by Bodie, Kane, and Marcus, Essentials of
Investments by Bodie, Kane, and Marcus, Fundamentals of Financial Management
by Brigham and Houston, and Intermediate Financial Management by Brigham and
Daves.

iv Examples include Spreadsheet Modeling in Corporate Finance by Holden,
Spreadsheet Modeling in Investments by Holden, Financial Analysis with Microsoft
Excel 2002 by Mayes and Shank, and Financial Modeling Using Excel and VBA by
Sengupta.

v We will explain these terms later in the paper.
vi Excel’s scenario manager can handle up to 32 stocks in a portfolio.  Beyond 32

stocks, Excel issues an error message.
vii The Adj. Close* column for stocks is a stock price whereas the Adj. Close* column

for the 13-week U.S. Treasury bill is an annualized return in percent, not a bond
price.  One method to compute a monthly return for the bond is to divide the Adj.
Close* column by 12 and to change the return from percent to decimal by dividing
by 100.

viii Students should be familiar with arithmetic averages and standard deviations from
a math course in high school or a finite math or business statistics course in college.
This further emphasizes how skills learned in one class are used in another.
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ix Students should be familiar with matrices from their finite math course.  The use of
matrices in this project further emphasizes how skills learned in one class are used
in another.

x Adding a dollar sign in front of a row or column index makes the reference to that
row or column absolute instead of relative.  In this case, without using dollar signs
in the formulas for the correlation matrix, we would have to go through this process
900 times (30x30).  Using dollar signs reduces this number to only 30!

xi Shorting is a process where investors sell stock by borrowing it from another
investor, then replace the borrowed stock at a later date by buying it in the market,
hopefully at a lower price.
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DIVERSITY AND SCHOOL DISTRICT
SPENDING

Peter M. Mitias, American University of Sharjah

ABSTRACT

This paper is an empirical investigation of the hypothesis that the degree
of homogeneity within a school district affects the mix of funding that the school
district receives.  The changing mix of school district finance has received a great
deal of attention recently (Murray et al 1998, Hoxby 1998,1996, Hanushek 1986,
Card and Krueger 1996).  While there has been a great deal of work on the equity
and efficiency of funding types, there has been little inquiry into the nature of the
variance in the mix of school district financing.  In this paper we develop a
framework that investigates the variance in the mix of output based on the relative
homogeneity of the school district population.  More specifically we hypothesize that
the more homogeneous the population, the more likely the funding will come from
local property tax base while the more heterogeneous populations will receive more
financing from higher level governments.  

INTRODUCTION

There is an extensive body of literature in economics regarding the
relationship between school district resources and outcomes, the interdependence
between income and education, equalization spending, and demographic effects on
school outcomes and finance.  However, only recently has attention been turned to
the issue of the mix and source of school district financing as both an efficiency
issue.

Hoxby (1996) notes that changes in the financing affects the fundamental
incentives that schools face, and thus changes the long term goals that they pursue,
regardless of a consensus on a "preferred" system of school finance.  It is these
incentives that support our hypothesis and are explored in Section three.  Pointing
out the many 'reforms' that attempt to either reduce local control or extend it with
regards to school finances reinforces the relevance of this issue.  Hoxby also points
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out that one of the most important trends in school finance funding is the decreased
reliance on local property tax-based financing in favor of higher-level government
finance, specifically state level equalization aid.1  However, the primary focus of her
work is on the efficiency-equity problem of school finance, and contends that local
finance resolves much of this problem.  Hoxby (1996) argues that the level of Public
Schooling is allocatively efficient when the primary source of funding is local
property taxed based financing because of the Tiebout process.  More importantly,
Hoxby notes that in these districts that there was a high degree of homogeneity
among households.  We contend that it is the degree of homogeneity in the district
that leads to more local property tax based finance, thus leading to allocative
efficiency.  It also begs the question:  when the primary source of funding is not
reliant on the local property tax base is allocative inefficiency the necessary
outcome?

The issue of the source and mix of school finance is also addressed by
Murray et al. (1998).  They investigate the impact of school finance equalization
reform on the distribution of resources and find that these reforms have increased
the aggregate level of spending on education and reduced the within-state
inequalities in school districts by 19 to 34 percent. This is accomplished primarily
through state funding by means of higher state taxes.  Also, they find that from
1972-1992 that the share of local spending was rising while the federal shares were
dwindling.  They attribute the increased percentage in state and local spending
shares to recent legislation and the resulting change in behavior.  However, this
work does not address why there were differences in the mix of these shares to start
with.

Hanushek (1986) extensively reviews the economics of education and
schooling and focuses on the production and efficiency aspects of schooling. This
deviates from the traditional inquiries into the ultimate uses of education.  Hanushek
also points out that federal funding jumped during the 60's and then slowed in
growth during in the 70's and declined during the 80's.  Hanushek, like Murray et.
al., attribute much of the changing trend in the financing of local to the extensive
legislation that restricted the use of local property tax on education funding.  One
key issue that this paper addresses is why these restrictions were put into place to
begin with.

We posit that there need not be a "preferred" system of finance for all school
districts.  We believe that the "preferred" system or mix of finance by the school
district is influenced by the relative homogeneity of the jurisdiction.  The hypothesis
is that school districts are more likely to seek more federal or state funding when the



95

Journal of Economics and Economic Education Research, Volume 9, Number 3,  2008

locality is more heterogeneous.  The combination of the notion that agents for the
school districts engage in rent seeking behavior and the increased costs for
heterogeneous groups to engage in collective decision making (reflecting a more
diverse set of preferences) support this hypothesis.  The question then becomes:  Is
the locality "financing with the feet?"  In other words, do Public Schools behave like
club goods and if so, does it hold to the standards of the Tiebout model?

We begin by assuming that the agents for school district are utility
maximizing bureaucrats whose ultimate goal is to stay elected (Romer and
Rosenthal 1978).  If so, then the agent(s) would stay elected by maximizing the
utility of the median voter in the jurisdiction.  We assume that the distribution of
preferences in the heterogeneous community will more uniform and the distribution
of preferences in the homogeneous distribution to be more centralized around the
mean.

Given the above assumptions, we can now examine the dilemma that the
agents of the districts face.  When the agent is faced with a heterogeneous
distribution of tastes and preferences, it becomes more difficult for the agents to
provide a bundle of services that will satisfy the desires of the local constituency.
In attempting to satisfy a more diverse group, the bundle of services that must be
offered will be more costly.  This will make some of the constituents less willing to
pay for the bundle of services.  The Tiebout model suggests that those people who
are not satisfied with the services or price will vote with their feet.  This means that
exiting individuals either change public schools (leaving the tax base) or move to
a private school (reducing the perceived benefits of local taxes).  This implies that
we would likely see more private schools in the more heterogeneous jurisdictions
than we would in the more homogeneous districts.  These relationships assume that
the primary source of funding is from the traditional property tax base.  The model
changes when the agent can seek alternative sources of funding.

With the existence of alternative sources of funding, the agent does not have
to be as sensitive to the taste and preferences of the local population.  The agent can
substitute away from local property tax based financing to state and federal sources.
The introduction of intergovernmental aid also provides the agent with the incentive
to create fiscal illusion.  The existence of intergovernmental aid can alter the
perceived price of the bundle of services by the median voter.  By controlling the
amount of information the voters have about the level and type of aid, the median
voter's perceived price of public schools would be less than the true marginal cost
of provision (Mitias and Turnbull 2001).  This lower perceived price, caused by
fiscal illusion, will allow for more schooling to be provided and satisfy more of the
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diverse community, thereby providing an incentive for the agent to seek alternative
sources of financing.

When examining the situation faced by voters in a heterogeneous district,
we adhere to the notion that the job of school finance is to create an environment
that induces people to invest for schooling that is socially optimal (Hoxby 1996).
Also, we accept that allocative efficiency arises in those districts that are primarily
financed by a local property tax because of the Tiebout process capitalizing the
value of local schools into local housing prices.  However, this does not imply that
allocative efficiency does not exist when the school district is not financed primarily
through the local property tax base. The reason for this is that the voters have the
option not only to vote with their feet (leave the Club) but also 'finance' with their
feet.

If constituents are not happy with the bundle of services provided some will
leave and some will end up substituting away from public to private schooling.
Those who are paying for private schooling are not likely to vote for any increases
in the local property tax base to finance public schools, since they are paying twice.
It is the notion that 'I am only willing to pay the Public Schools if I can get what I
want'.  If this alienated segment of the population is disenchanted then this leaves
the tastes and preferences of the remainder of the local population for the agent to
satisfy. The constituents of the school district are more likely to demand that the
agents seek state and federal funding sources in order to provide a bundle of services
that will satisfy them.

Our empirical task is to investigate the relationship between measures of the
heterogeneity of the population and different types of funding by school districts
within those counties.  At the county-level of analysis, we were able to obtain data
on several characteristics of the population for which measures of heterogeneity
could be constructed: income, education, race, and age.  To do so, we generated
Herfindahl-type index numbers for each variable by summing the squares of the
percentage of the population that fell into each category.  For example, there were
six categories for income.  A perfectly homogeneous population with respect to
income would be obtained when everyone in the population reported income in the
same category.  The Herfindahl index would achieve a value of 1.  A completely
heterogeneous population would consist of 1/6 of the population falling into each
of the six income categories, which would give the Herfindahl index a value of
0.167.  There were three education categories: (1) over 25 years of age without a
high school diploma, (2) over 25 years of age with a HS degree, and (3) over 25
years of age with a college degree.  Again, a perfectly homogeneous population
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would be characterized by Herfindahl index of 1; a perfectly heterogeneous
population would have a value of 0.33.  Race was calculated using 5 categories:
white, black, native American, Asian/Pacific Islander, and Other.  This gives a range
of Herfindahl values between 0.2 and 1.  Finally, the age variable contained 9
categories, with a Herfindahl Index between 0.11 and 1.

School district information was obtained from the Digest of Education
Statistics 2000.    From this source, revenues by source and expenditures by type
were obtained and the school district data is for school districts with 15,000 or more
students.  The remaining data were obtained from the U.S. Census.

The specific model we estimated is:

FUNDINGj = α0 + α1INCij + α2EDUCij + α3RACEij + α4AGEij + εij

Where
FUNDNGj = the level of funding by type, j= federal, state, and local.
INCi  = the Herfindahl-based measure of the dispersion in per capita

income in 1992.
EDUCi = the Herfindahl-based measure of the dispersion in educational

attainment in 1992.
RACEi = the Herfindahl-based measure of racial diversity across a county

in 1992.
AGEi = the Herfindahl-based measure of the dispersion in age groups in

1992.

We expect dispersion in per capita income, education, race, and age to be
positively correlated with a greater demand for federal funding in a school district.
Since the Herfindahl measures achieve higher values with homogeneous populations
and lower values with heterogeneous ones, the measured relationships are expected
to be negative.

How sensitive are education expenditures to Federal State and Local
government funding.  Which is more elastic?  Does the elasticity change with
respect to whether the jurisdiction is more or less homogenous?

Our estimation procedure was Ordinary Least Squares regression.  Our
results for the 179 coterminous school districts and counties across the U.S. are
presented in Table 1 and discussed below.
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Table 1: Federal Funding

Coefficients Standard Error t stat P-value

Intercept 274613.30 59621.81 4.61 8.2E-06

Age -71.83 37.08 -1.94 5.4E-02

Educ -11.60 11.30 -1.03 3.1E-01

Income -24.82 14.65 -1.69 9.2E-02

Race -10.03 3.02 -3.32 1.1E-03

We observe that the income, race, and age measures of population
homogeneity all exert a significant impact on the level of federal funding received
by the school district.2 As the measure of dispersion increases (indicating greater
homogeneity), the estimated level of federal funding declines, ceteris paribus.  The
effect is most pronounced with respect to race.  The f-statistic of 8.64 is also
significant and suggests the coefficients jointly explain the changes in federal
funding.  As a school district's heterogeneity increases in these categories we see a
pronounced move towards more federal funding. This may be the result or
rent-seeking behavior by school officials, or a way for the school to reduce the price
local price while still increasing the bundles of services offered.  Given the previous
assumption that schools are club goods, greater heterogeneity will lead to a more
diverse bundle to be offered. Consequently, if the necessary conditions for
voting-with-the-feet exist, federal funding is a way to finance the current bundle,
when the median voter may prohibit an increase in local taxes (an increase in the
club fees). The education variable is not significantly different than 0.  This may
result from the lack of variation associated with only three categories of dispersion.

A second model was run to estimate if the effects of dispersion hold on the
level of state funding demanded by a county.  The results are presented in Table 2.
As the table demonstrates, state funding is equally explained by changes in
dispersion.  The magnitudes are smaller, which corresponds to the smaller
contributions given by states.  Further, the dispersion on the income variable is
much more pronounced at the state-level. This suggests that state legislators where
revenue is generated by an income tax are much more likely to seek financing
control when the chance of redistribution locally is greater (as would be the case
with increased levels of heterogeneity).
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Table 2: State Funding

Coefficients Standard Error t Stat P-value

Intercept 1321315.50 330660.48 4.00 0.00

Age -334.63 205.62 -1.63 0.11

Educ -3.97 62.67 -0.06 0.95

Income -193.84 81.25 -2.39 0.02

Race -57.60 16.73 -3.44 0.00

In this paper we demonstrate that there is evidence to suggest that dispersion
among groups in a school district leads to greater levels of external funding.   This
further suggests that schools behave like 'clubs' and where heterogeneity exists in
communities, the school system has to offer an increasingly diverse bundle of goods.
This investigation has given rise to several new testable hypotheses.  The evidence
implies that further theoretical and empirical investigation of these relationships is
warranted.  

ENDNOTES

1.  Equalization aid is revenue aid that is directed toward districts with low property
value per student (Hoxby, 1996).

2.  The education variable is not significantly different than 0.  This may result from
the lack of variation associated with only three categories of dispersion.
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AN ANALYSIS OF ATTITUDES TOWARD
FOREIGN TRADE

Anil K. Lal, Pittsburg State University
Bienvenido S. Cortes, Pittsburg State University

ABSTRACT

Recent developments in communications technology have made the world
a global work place. This changed business environment has created immense
opportunities and challenges for businesses as well as universities which need to
increase the supply of graduates who are capable of handling international business
responsibilities. Using a questionnaire administered to undergraduate International
Trade students at the beginning (pre-sample) and at the end (post-sample) of the
semester, this paper analyzes differences in attitudes of students toward foreign
trade based on age, major, gender, knowledge, and citizenship. 

INTRODUCTION

Advancements in technologies continue to bring countries ever closer. It is
not surprising that the share of imports of goods and services in world GDP has
increased from 12 percent in 1965 to 24.8 percent in 2000 and has stayed constant
since then. Not only are countries purchasing relatively more goods and services
from outside, but significant developments in telecommunications have brought
different parts of the world much closer to one another. A remarkable development
of the past decade is that the world is truly becoming a global work place. The
outsourcing of white-collar jobs from Europe and the U.S. to other countries attests
to this phenomena. As countries become more interdependent, it is essential to train
the labor force to have a better understanding of the international business
environment. This need to have a globally conscious workforce has created
pressures on colleges and universities to internationalize their curriculum (see, for
example, Webb, Mayer, Pioche & Allen, 1999). Responding to this need, the U.S.
Department of Education introduced a number of initiatives to promote international
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education and research. Many institutions have received funding to develop specific
international programs emphasizing business techniques, foreign languages, and an
understanding of diverse cultures and customs (see, for example, Cant, 2004).
Moreover, the American Assembly of Collegiate Schools of Business (AACSB)
changed its accreditation standard in 1974 to require the internationalization of the
business curriculum.

A major objective and challenge of business schools is to prepare students
for the rapidly changing business environment. Ahlawat (2006) notes that this is
particularly difficult for smaller schools which primarily serve students who come
from neighboring areas and who have little exposure and sensitivity to cross-cultural
differences. The biggest hurdle in internationalizing the curriculum often stems from
a lack of desire on the part of students to appreciate the international business
environment or to think globally. Given the importance of understanding the
international aspects of business and the difficulties faced by smaller schools, it will
be interesting to examine the attitudes and basic international trade knowledge of
students at Pittsburg State University (PSU)1. 

In their 2005 study, Mayda and Rodrik analyze differences in attitudes
towards foreign trade using two cross-country data sets. They find that pro-trade
preferences are significantly related to an individual's level of human capital, in the
manner predicted by the factor endowment model. Thus, highly educated individuals
tend to be pro-trade in countries that are well-endowed in human capital (for
example, U.S. and Germany), but are anti-trade in countries that are poorly endowed
with human capital (for example, Philippines and Bangladesh). They also find
empirical support for the specific factors model. A person's trade preferences are
partly related to the trade exposure of the sector in which an individual is employed:
individuals in non-trade sectors tend to be more pro- trade, while individuals in
import-competing sectors are more protectionist. They also show that non-economic
determinants play a very important role in preferences towards trade. For example,
a high degree of neighborhood attachment and nationalism is associated with
protectionist tendencies, while cosmopolitanism is correlated with pro-trade
attitudes. Other things constant, individuals who have greater confidence in the
workings of domestic political and economic institutions are less likely to be
protectionist. Other studies of individual preferences regarding international trade
also indicate that individuals are guided primarily by self-interest and the
environment.

The purpose of this paper is to examine the differences in attitudes towards
foreign trade among a sample of students enrolled in an undergraduate class in
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international trade. Specifically, using responses of students to a questionnaire
administered at the beginning and end of the semester, this paper seeks to explain
differences in attitudes (when students are classified according to some
characteristics) and whether these attitudes change after exposure to international
trade issues. Section II of this paper outlines the survey methodology and
summarizes the results. Section III explains the differences in attitudes based on
regression analysis. The final section summarizes the main findings and conclusions.

SURVEY, METHODOLOGY AND RESULTS

In the fall 2006 term, a questionnaire was administered to an undergraduate
International Trade (ECON 640) class on the first and last day of classes. This
survey consisted of three parts: (1) questions regarding demographics and other
student information; (2) questions about student attitudes toward foreign trade, and;
(3) questions about students' basic knowledge of foreign trade. Participation in this
survey was voluntary and 57 out of 77 students participated. Table 1 below
summarizes the characteristics of the sample.

Table 1: Personal Information

S. No. Characteristic/Sub-Group/Variable Number of Students

(1) (2) (3)

A SAMPLE SIZE

A.1 Total Number of Students 77

A.2 Total Number of Respondents 57

B CITIZENSHIP

B.1 U. S. Citizens 45

B.2 Non U. S. Citizens 12

C POLITICAL AFFILIATION

C.1 Democrats 10

C.2 Republicans 22

C.3 Independent/Undecided 25

D GENDER

D.1 Females 25
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D.2 Males 32

E AGE DISTRIBUTION

E.1 Younger Students (below 25 years of age) 50

E.2 Older Students (over 25 years of age) 7

F MAJOR

F.1 Management/Marketing 47

F.2 Others 17

 Table 1 shows that 50 of the 57 respondents are younger students, 32 are
male, 45 are U.S. citizens, and 47 are management/marketing majors2. Moreover,
22 students identify themselves as Republican, 10 Democrats, and 25 independent
or undecided voters.

Analysis of Attitudes

The second part of the survey on attitudes consists of five questions
designed to reflect student attitudes toward foreign trade.  The student's response to
each question is assigned a score in the following manner: "1" if the choice reflects
a pro-trade preference and "0" otherwise. The scores are added for each student and
the overall attitude score ranges from 0 to 5, with higher scores reflecting more
pro-trade attitudes. These attitude scores are compiled for each respondent in the
pre- and post-sample surveys. Table 2 outlines mean attitude scores for each
category (sub-group) based on responses to the questionnaire, on a pre- and
post-sample basis. Table 3 outlines the results for a null hypothesis of means
equality between different categories in the pre- and post-samples.

Hypothesis 1:  Do mean attitude scores vary across different sub-groups,
when sub-groups are characterized by personal characteristics or
attributes?

The average attitude score for all 57 respondents is 3.63 in the pre-sample
phase and 3.86 in the post-sample phase. In the pre-sample phase, the average
attitude score of US citizens, Republicans, females, below 25 years of age, and
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management/marketing majors is higher than the overall class average. In the
post-sample phase, the average attitude score of US citizens, Democrats, males, and
management/marketing majors is higher than the class average.

Table 2: Mean Attitude Scores

S.
No. 

Characteristic/
Sub-Group/Variable

Sample
Size

Pre - Sample
Mean

Attitude
Score 

(Standard
Errors)

Post - Sample
Mean

Attitude
Score 

(Standard
Errors)

Test of
Differences in
Mean Attitude
Scores in Pre -

and Post
Samples: t

statistic
(Probability)

 (1) (2) (3) (4) (5) (6)

A All Respondents 57 3.63 (0.13) 3.86 (0.09) 1.44 (0.15)

B.1 U. S. Citizens 45 3.76 (0.15) 3.98(0.09) 1.26 (0.21)

B.2 Non U. S. Citizens 12 3.17 (0.21) 3.42 (0.23) 0.81 (0.33)

C.1 Democrats 10 3.20 (0.25) 3.90 (0.18) 2.28 (0.04)

C.2 Republicans 22 3.77 (0.22) 3.77 (0.16) 1.95 (0.06)

D.1 Females 25 3.76 (0.21) 3.80 (0.14) 0.16 (0.88)

D.2 Males 32 3.53 (0.16) 3.91 (0.12) 1.85 (0.07)

E.1 Younger Students
(below 25 years of age)

50 3.72 (0.14) 3.42 (0.19) 1.06 (0.29)

E.2 Older Students (over 25
years of age)

7 3.00 (0.31) 3.75 (0.20) 1.55 (0.15)

F.1 Management/Marketing 47 3.74 (0.90) 3.96 (0.62) 1.34 (0.18)

F.2 Others 10 3.10 (1.19) 3.40 (0.84) 0.64 (0.53)

We find that US citizens have a higher average attitude score compared to
non-US citizens in both pre- and post-samples (Table 2). The null hypothesis of
equality between mean attitude scores of US and non-US citizens is rejected at the
90% level of confidence in samples (Table 3). Thus, US citizens are consistently
more pro-trade. This result is contrary to Mayda and Rodrik who find that US
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citizens are protectionist.  We also test whether attitudes toward foreign trade differ
because of party affiliations and/or beliefs. Our results show that Democrats, who
tend to have a lower mean pre-attitude score, are statistically different (at the 80%
confidence level) from Republicans. Thus, Republicans are more pro-trade, a
finding that corresponds with our initial expectations. However, we could not reject
the null hypothesis of difference in means between Democrats and Republicans in
the post-sample phase. This suggests that the attitudes of Democrats are no different
than those of Republicans after taking a course in international trade.

Table 3: Equality of Mean Attitude Scores between different sub - groups in Pre -
and Post - samples

S. No. Characteristic/
Sub-Group/Variable

Test of Differences in
Mean Attitude Scores in

Pre - Sample: t -
statistics (probability)

Test of Differences in
Mean Attitude Scores in

Post - Sample: t -
statistics (probability)

 (1) (2) (3) (4)

A. U. S. versus Non - U. S.
Citizens

1.90 (0.06) 2.62 (0.01)

B. Democrats versus
Republicans

1.57 (0.13) 0.48 (0.64)

C. Males versus Females 0.88 (0.38) 0.57 (0.57)

D. Younger versus Older
Students

1.87 (0.07) 0.27 (0.79)

E. Management/Marketing
versus Other Majors

1.94 (0.06) 2.41 (0.02)

Though female students have a relatively higher pre-sample mean attitude
score as compared to male students, the null hypothesis of test of equality of
pre-attitude mean scores could not be rejected even at the 80% level of confidence.
The same result is confirmed in the post-sample phase. Thus, we find no differences
in attitudes based on gender. Table 2 shows that the younger students had a higher
pre-sample mean attitude score than the older students. Null hypothesis of tests of
equality of means between these two categories was rejected at 90% level of
confidence, and thus the younger students were more open to trade relative to the
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older students in the pre-sample phase.  However, we could not reject the null
hypothesis of no difference in mean attitudes scores between the two age groups in
the post-sample phase. Finally, the mean attitude score of management/marketing
majors is higher than that of other majors in both the pre- and post-samples. Tests
of equality of means between these two sub-categories show that
management/marketing majors are more open to foreign trade and this difference
does not change with a course in international trade.

Thus, our results show that attitudes toward foreign trade can be different
based on citizenship, political affiliation, age, and major area of study. However, we
detect no difference in attitudes based on gender. We also find that some sub-groups
are more likely to change their attitudes towards foreign trade as compared to others.

Hypothesis 2: Do attitudes change after a basic course in international
trade?

Column (6) in Table 2 provides the test results of a null hypothesis of no
statistical difference in mean attitude scores of different sub-groups in the pre- and
post-samples. We find that the overall mean attitude score of the class is higher in
the post-sample relative to the pre-sample. The raw mean scores for different
sub-groups are also greater (except for younger students) in the post-sample relative
to the pre-sample. Statistically, Democrats, males, students over 25 years of age, and
management/marketing majors tend to raise their scores after undergoing a course
in international trade. There are no changes in attitudes in the other sub-groups. It
is important to note that no category tended to become less pro-trade after the trade
course. 

Analysis of Knowledge

The third part of the questionnaire consists of ten questions designed to
assess the students' basic knowledge of foreign trade. Each correct response receives
a score of 1 and an incorrect response receives a score of 0. These scores are added
for each student, with the knowledge score ranging from 0 to 10 in the pre- and
post-samples. Table 4 outlines the mean knowledge scores of different categories
in the pre- and post-samples. Table 5 outlines the test results for a null hypothesis
of equality of mean knowledge between different categories in the pre- and
post-samples.
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Table 4: Mean Knowledge Scores

S. No. Characteristic/
Sub-Group/

Variable

Sample
Size

Pre - Sample
Mean

Knowledge
Score  (Standard

Errors)

Post - Sample
Mean

Knowledge
Score  (Standard

Errors)

Test of
Differences in

Mean
Knowledge

Scores in Pre -
and Post

Samples: t
statistic

(Probability)

 (1) (2) (3) (4) (5) (6)

A All
Respondents

57 4.81 (0.24) 4.96 (0.23) 0.48 (0.63)

B.1 U. S. Citizens 45 4.29 (0.22) 4.56 (0.24) 0.83 (0.41)

B.2 Non U. S.
Citizens

12 6.75 (0.43) 6.50 (0.44) 0.41 (0.69)

C.1 Democrats 10 4.80 (0.33) 4.60 (0.69) 0.26 (0.80)

C.2 Republicans 22 4.64 (0.44) 5.18 (0.40) 0.94 (0.35)

D.1 Females 25 4.40 (0.36) 4.44 (0.34) 0.08 (0.94)

D.2 Males 32 5..13 (0.31) 5.38 (0.30) 0.58 (0.56)

E.1 Younger
Students

(below 25
years of age)

50 4.72 (0.26) 4.88 (0.25) 0.44 (0.66)

E.2 Older Students
(over 25 years

of age)

7 5.43 (0.37) 4.96 (0.61) 0.20 (0.84)

F.1 Management/
Marketing

47 4.51 (1.74) 4.79 (1.73) 0.77 (0.44)

F.2 Others 10 6.20 (1.23) 5.80 (1.69) 0.61 (0.55)
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Table5: Equality of Mean Knowledge Scores between different sub - groups in Pre
- and Post - samples

S. No. Characteristic/
Sub-Group/

Variable

Test of Differences in
Mean Knowledge

Scores in Pre - Sample: t
- statistics (probability)

Test of Differences in
Mean Knowledge

Scores in Post - Sample:
t - statistics (probability)

 (1) (2) (3) (4)

A. U. S. versus Non - U. S.
Citizens

5.14 (0.00) 3.80 (0.00)

B. Democrats versus
Republicans

0.25 (0.80) 0.77 (0.45)

C. Males versus Females 1.55 (0.13) 2.06 (0.04)

D. Younger versus Older
Students

0.99 (0.33) 0.98 (0.33)

E. Management/Marketing
versus Other Majors

2.91 (0.01) 1.69 (0.09)

Hypothesis 3: Does basic knowledge vary across different sub-samples
when sub-samples are characterized by personal characteristics or
attributes?

The average knowledge score for all 57 respondents is 4.81 in the
pre-sample phase and 4.96 in the post-sample phase. In the pre-sample phase, the
average knowledge scores of non-US citizens, males, younger students, and other
majors exceed the overall class average. In the post-sample phase, the average
knowledge scores of non-US citizens, Republicans, males, older students, and other
majors are higher than the overall class average.

Non-US citizens have a higher knowledge score than US citizens in both the
pre-and post-samples. The null hypothesis of equality of mean knowledge scores
between US and non-US citizens is rejected at the 90% confidence level of
confidence in both samples. Although the score of Democrats is higher than that of
Republicans in the pre-sample phase, the situation is reversed in the post-sample
phase. However, results show that there is no statistical difference in mean attitudes
scores of Republicans and Democrats in either sample.

Male students have a higher average knowledge score than females in both
samples. The null hypothesis of equality of mean scores between males and females
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is rejected (at the 80% level) in the pre-sample and likewise (at the 90% level) in the
post-sample. Thus, the knowledge score of male students is statistically higher than
that of female students in both sample phases. When respondents are classified
according to age, older students are found to have a higher mean knowledge score
than younger students in both samples. However, Table 5 shows that there is no
statistical difference in mean scores based on the age of the respondents. Finally,
management/marketing majors consistently have a lower mean score compared to
other majors. The null hypothesis of equality is rejected (at the 90% level) in both
samples. Thus, the basic knowledge of other majors is statistically greater than that
of management/marketing majors in both pre- and post-samples. 

Hypothesis 4: Does basic knowledge change with an undergraduate course
in international trade?

Column (6) in Table 4 also outlines the t-statistics and probability of not
rejecting the null hypothesis.  Figures in column (6) reveal that there is no statistical
difference in means scores of different categories in the pre- and post-sample phases,
and thus the null hypothesis of equality of means cannot be rejected at 80 or 90%
level of confidence.

Several results are worth noting. First, the mean knowledge scores of
non-US citizens, male students, and other majors are greater in both sub-samples.
Second, there is no difference in mean knowledge scores based on age and party
affiliations. Finally, the knowledge score for each category of students did not
change with a course in international trade.

Analysis of Scores

Table 6 below outlines the average percent scores received by different
groups of students in the international trade course (based on quizzes, exams,
homework, and class work assignments). The overall average score for all
respondents (57) is 80.52. The average score for US citizens is 77.8 while for
non-US citizens it is a high 90.61. The average scores for Democrats and
Republicans are close (81.2). The average score for females is marginally lower at
79.30 relative to male score of 81.5. The score for younger students is 80.9, higher
than that for older students at 77.5. Similarly, the average score for
management/marketing majors is slightly lower at 80.3 as compared to other majors
at 81.7.
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Table 6: Mean  Scores (percent)

S. No. Characteristic/Sub-Group/
Variable

Sample Size Mean Scores
  (Standard Errors)

 (1) (2) (3) (4)

A All Respondents 57 80.52 (2.76)

B.1 U. S. Citizens 45 77.83 (1.82)

B.2 Non U. S. Citizens 12 90.61 (4.16)

C.1 Democrats 10 81.17 (5.07)

C.2 Republicans 22 81.18 (2.47)

D.1 Females 25 79.30 (2.50)

D.2 Males 32 81.48 (2.57)

E.1 Younger Students (below 25 years of
age)

50 80.94 (1.79)

E.2 Older Students (over 25 years of age) 7 77.54 (7.63)

F.1 Management/Marketing 47 80.27 (12.25)

F.2 Others 10 81.71 (19.64)

Table7: Equality of Mean Scores between different sub - groups in Pre - and Post -
samples

S. No. Characteristic/Sub-Group/Variable Test of Differences in Mean Knowledge
Scores in Pre - Sample: t - statistics

(probability)

 (1) (2) (3)

A. U. S. versus Non - U. S. Citizens 3.10 (0.00)

B. Democrats versus Republicans 0.002 (0.99)

C. Males versus Females 0.59 (0.56)

D. Younger versus Older Students 0.61 (0.54)

E. Management/Marketing versus
Other Majors

0.30 (0.76)
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Table 7 provides the results of equality tests of mean scores between
different categories.  We find a statistical difference only between US and non-US
citizens in terms of average test scores.

REGRESSION RESULTS

The following regression model is used to analyze attitudes towards foreign
trade in the post sample:

ATT = f(DVy, DVr, DVus, DVf, DVm, KNOW, SCORE)
where
ATT: attitude score for all respondents in the post-sample.
DVy: 1 if student is below 25 years of age, 0 otherwise.
DVr: 1 if student considers oneself a Republican, 0 otherwise.
DVus:  1 if student is a US citizen, 0 otherwise.
DVf: 1  if student is a female, 0 otherwise.
DVm: 1 if student is a management/marketing major, 0 otherwise.
KNOW: knowledge score for all respondents on test in the post-sample.
SCORE: Raw scores in International Trade course.

We apply the standard ordinary least squares procedure to estimate the
model. The interpretation of the constant term is important as it represents the
average for older students, non-Republicans, non-US citizens, and males. Thus all
comparisons are made to this typical student.

Our results show that the coefficient for younger students is positive, but
statistically insignificant. In this case, the sign of the coefficient is inconsistent with
our earlier findings (although the statistical (in)significance is consistent with our
earlier finding). Respondents who identify themselves as Republicans have a mean
attitude score lower than non-Republicans (i.e., Democrats and
independent/undecided); however, this estimated coefficient is not statistically
significant. Female students have a lower mean attitude score than male students and
this coefficient is statistically different from zero at the 90% level. In our earlier
survey findings, we observe a higher raw attitude score for male students relative to
female students, but do not find statistical difference between the two genders. 

In the case of US citizens, we find that the mean attitude score is greater
than that of non-US citizens and these mean scores are significant at the 95%
confidence level. Finally, the mean attitude score of management/marketing majors
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is higher than that of other majors, and this difference is statistically significant at
the 95% level. Both these results (sign as well as the level of significance) are
consistent with our earlier findings.

Table 8: Regression Results

S. No. Variable Coefficient (t - statistic)

(1) (2) (3)

A. Constant 2.57 * (3.74)

B. DVy 0.20 (0.81)

C. DVr -0.19 (-1.11)

D. Dvus 0.48* (2.07)

E. DVf -0.29** (-1.73)

F. DVm 0.44 * (1.95)

G. KNOW -0.13* (-2.17)

H. SCORE 0.02* (2.17)

I. R2 0.34

J. Adj R2 0.24

K. F- Statistic 3.59

Note:
* represents significant at 90 % level of confidence.
** represents significant at 80 % level of confidence.

The coefficient associated with knowledge is negative and significant at the
95% level, indicating that more knowledge about international trade issues has a
negative impact on attitudes towards foreign trade. Finally, the coefficient associated
with scores (performance) in international trade class is positive and significant,
indicating that better understanding of international trade issues has a positive
impact on attitudes towards trade.
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SUMMARY AND CONCLUSIONS 

This study is based on the expectation that a basic course in international
trade, which exposes students to the concepts of foreign trade and its consequences
(both positive and negative), would result in a positive change in overall attitudes.
We also posit that attitudes depend on the characteristics and attributes of the
respondents.  Our results confirm the expectation that a course in international trade
results in a positive or favorable change in attitudes. At a disaggregated level, our
results confirm that attitudes toward trade are related to various attributes and
demographics of the students.

We initially expected that better information (or basic knowledge) about the
world and issues related to foreign trade would lead to higher mean attitude score.
However, our results show that basic knowledge regarding global issues leads to a
lower mean attitude score.  Thus, increased knowledge about trade does not
necessarily imply a better understanding of trade issues. 

We expected that better performance in international trade course (as
reflected by raw scores on exams, quizzes, etc.), reflecting better understanding of
issues relating to foreign trade, would have a positive impact on attitudes towards
foreign trade. Our results indicate that strong performance in an international trade
course leads to a more positive change in attitudes toward foreign trade. 

This study is based on responses of students to a questionnaire administered
to a class at a small regional university. It will be interesting to extend this study to
other institutions, both in the US and overseas.

ENDNOTES

1. PSU is a regional university in the state of Kansas and offers bachelors and masters
degrees, with an overall enrollment of about 6,700 students. The bachelors and
masters degree programs from the College of Business, which has 1700 students,
are accredited by the AACSB International. More important, the College of
Business has been the recipient of a Title VIB Business and International Education
(BIE) grant from the Department of Education three consecutive terms beginning
in 2001. Among other activities, the BIE grant has resulted in the development and
implementation of a new International Business major and an International Business
concentration in the MBA program, provision of outreach activities to local
businesses, and the development of study abroad programs and sister-school ties in
various countries in Central Asia, Central America, South America, and Asia.
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2. Includes seven double majors and so the total number of majors may be greater than
the total number of respondents.
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